
SCX-4600 Series
SCX-4623 Series

Multi Functional Printer
User’s Guide

imagine the possibilities
Thank you for purchasing a Samsung product.



Copyright_ 2

copyright
© 2009 Samsung Electronics Co., Ltd. All rights reserved.
This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.
Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and Samsung logo are trademarks of Samsung Electronics Co., Ltd.
• Microsoft, Windows, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation.
• TrueType, LaserWriter and Macintosh are trademarks of Apple Computer, Inc.
• All other brand or product names are trademarks of their respective companies or organizations.

REV. 1.00



Content

Content_ 3

COPYRIGHT 

2
CONTENT 

3
9 Safety information

13 Regulatory information
22 About this user’s guide
24 Features of your new product

INTRODUCTION 

26
 26 Machine overview
26 Front view
27 Rear view

 28 Control panel overview (SCX-4623 Series)
 29 Control panel overview (SCX-4600 Series)
 30 Understanding the Status LED
 30 Introducing the useful buttons
30 Menu button
30 (Power button)
30 Print screen button

 30 Turning on the machine

GETTING STARTED 

31
 31 Setting up the hardware
 31 Supplied software
 32 System requirements
32 Windows
32 Macintosh
32 Linux

 33 Installing USB connected machine’s driver
33 Windows
34 Macintosh
34 Linux

 35 Sharing your machine locally
35 Windows
36 Macintosh

NETWORK SETUP 

37
 37 Network environment
 37 Introducing useful network programs
37 SyncThru™ Web Service
37 SyncThru™ Web Admin Service
37 AnyWeb Print
37 SetIP

 37 Using a wired network
37 Printing Network Configuration report
38 Setting IP address
39 Network parameter setting
39 Restoring factory default settings

 39 Installing wired network or USB connected machine’s driver
39 Windows
41 Macintosh
41 Linux

 42 IPv6 Configuration
42 Activating IPv6
42 Setting IPv6 addresses

Content



Content

Content_ 4

42 Connecting SyncThru Web Service

BASIC SETUP 

43
 43 Altitude adjustment
 43 Changing the display language
 43 Setting the date and time
 43 Changing the clock mode
 44 Changing the default mode
 44 Setting sounds
44 Speaker, ringer, key sound, and alarm sound
44 Speaker volume

 44 Entering characters using the number keypad
44 Entering alphanumeric characters
44 Keypad letters and numbers
44 Correcting numbers or names
45 Inserting a pause

 45 Using the save modes
45 Using toner saving feature
45 Using power saving feature

 45 Setting the default tray and paper
45 In the control panel
45 In the computer

 46 Setting job timeout

MEDIA AND TRAY 

47
 47 Preparing originals
 47 Loading originals
47 On the scanner glass
48 In the document feeder

 48 Selecting print media
48 Guidelines to select the print media
48 Media sizes supported in each mode

 48 Changing the tray size
 49 Loading paper in the tray
49 Tray 1
49 Manual tray

 50 Printing on special media
51 Envelope
51 Transparency
51 Labels
52 Card stock/ Custom-sized paper
52 Letterhead/ Preprinted paper
52 Photo
52 Glossy

 52 Setting the paper size and type
52 Setting the paper size
52 Setting the paper type
52 Setting the paper source

 53 Using the output support
53 Stacking papers firmly

PRINTING 

54
 54 Printer driver features
54 Printer driver

 54 Basic printing
55 Canceling a print job

 55 Opening printing preferences



Content

Content_ 5

55 Using a favorite setting
 55 Using help
 55 Using special print features
55 Printing multiple pages on one sheet of paper
56 Printing posters
56 Printing booklets (Manual)
56 Printing on both sides of paper (Manual)
57 Change percentage of your document
57 Fitting your document to a selected paper size
57 Using watermarks
57 Using overlay
58 Advanced Options

 58 Changing the default print settings
 59 Setting your machine as a default machine
 59 Printing to a file (PRN)
 59 Macintosh printing
59 Printing a document
59 Changing printer settings
60 Printing multiple pages on one sheet of paper

 60 Linux printing
60 Printing from applications
61 Printing files
61 Configuring Printer Properties

COPYING 

62
 62 Basic copy
 62 Changing the settings for each copy
62 Changing the darkness
62 Selecting the type of originals
62 Reducing or enlarging copies

 63 Changing the default copy settings
 63 Using special copy features
63 ID card copying
63 2-up or 4-up copying (N-up)
63 Poster copying
64 Clone copying

 64 Deciding the form of copy output 
 64 Setting copy timeout

SCANNING 

65
 65 Basic scanning method
 65 Scanning originals and sending to your computer (Scan to PC)
65 For USB connected machine
65 For network connected machine

 66 Using Samsung Scan Manager
66 Set Scan Button tab
67 Change Port tab

 67 Scanning with TWAIN-enabled software
 67 Scanning using the WIA driver
67 Windows XP
67 Windows Vista

 67 Macintosh scanning
67 Scanning with USB
68 Scanning with network

 68 Linux Scanning
68 Scanning
69 Adding Job Type Settings



Content

Content_ 6

69 Using the Image Manager

FAXING 

70
 70 Preparing to fax
 70 Sending a fax
70 Setting the fax header
70 Sending a fax 
70 Sending a fax manually
71 Confirming a transmission
71 Automatic redialing
71 Redialing the last number
71 Sending a fax to multiple destinations
71 Delaying a fax transmission
72 Sending a priority fax

 72 Receiving a fax
72 Changing the receive modes
72 Receiving manually in Tel mode
72 Receiving automatically in Answering Machine/Fax mode
73 Receiving faxes manually using an extension telephone
73 Receiving faxes using DRPD mode
73 Receiving in secure receiving mode
73 Activating secure receiving mode
73 Receiving faxes in memory

 73 Adjusting the document settings
73 Resolution
74 Darkness

 74 Forwarding a fax to other destination
74 Forwarding a sent fax to other destination by a fax
74 Forwarding a received fax to other destination by a fax
74 Forwarding a sent fax to other destination by an email
75 Forwarding a received fax to other destination by an email
75 Forwarding a sent fax to other destination by a server
75 Forwarding a received fax to other destination by server

 75 Setting up address book
75 Speed dial numbers
75 Group dial numbers
76 Searching Address Book for an entry

 76 Printing sent fax report automatically

MACHINE STATUS AND ADVANCED FEATURE 

77
 77 Fax setup
77 Changing the fax setup options
77 Sending
77 Receiving
78 Change Default
78 Auto Report

 78 Copy setup
78 Changing the copy setup options
79 Change Default

 79 Printing a report
 79 Clearing memory
 80 Network
 80 Menu overview



Content

Content_ 7

MANAGEMENT TOOLS 

82
 82 Introducing useful management tools
 82 Using SyncThru™ Web Service
82 To access SyncThru™Web Service:
82 SyncThru™Web Service overview
82 Setting the contact information

 83 Using the Smart Panel program
83 Understanding Smart Panel
83 Changing the Smart Panel Program Settings

 83 Smarthru
 83 Using SetIP program
84 Windows
84 Macintosh
84 Linux

 84 Using the Linux Unified Driver Configurator
84 Opening the Unified Driver Configurator
85 Printers configuration
86 Scanners configuration
86 Ports configuration

MAINTENANCE 

87
 87 Printing a machine report
 87 Monitoring the supplies life
 87 Using toner low alert
 87 Finding the serial number
 87 Cleaning a machine
87 Cleaning the outside
87 Cleaning the inside
88 Cleaning the scan unit

 88 Storing the Toner cartridge
89 Handling instructions
89 Use of non-Samsung and refilled toner cartridge
89 Estimated cartridge life

 89 Tips for moving & storing your machine

TROUBLESHOOTING 

90
 90 Redistributing toner
 90 Clearing original document jams
 91 Tips for avoiding paper curls
 91 Tips for avoiding paper jams
 92 Clearing paper jams
92 In tray 1
92 In the manual tray
92 Inside the machine
93 In exit area

 94 Understanding display messages
94 Checking display messages

 94 Solving other problems
94 Paper feeding problems
95 Printing problems
96 Printing quality problems
98 Copying problems
99 Scanning problems

100 Fax problems
100 Samsung Scan Manager Problem
100 Common Windows problems
101 Common Linux problems
102 Common Macintosh problems



Content

Content_ 8

SUPPLIES AND ACCESSORIES 

103
 103 How to purchase
 103 Available supplies
 103 Available maintenance parts
 103 Replacing the toner cartridge
 104 Checking replaceable’s lifespan

SPECIFICATIONS 

105
 105 General specifications
 106 Printer specifications
 107 Scanner specifications
 107 Copier specifications
 108 Facsimile specifications
 109 Print media specifications 

CONTACT SAMSUNG WORLDWIDE 

110



Safety information_ 9

safety information
These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any 
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

OPERATING ENVIRONMENT

 Warning

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.

 This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 

 Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarrettes, 
etc.).

 This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 

 This could result in electric shock or fire. 
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 Caution

OPERATING METHOD

 Caution

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.

 This could result in electric shock or fire. 

During an electrical storm or for a period of 
non-operation,remove the power plug from the 
electrical outlet. 

 This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

 Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
 Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

 This could result in electric shock or fire. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.

 Otherwise, this could result in electric shock or fire..

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 

service personnel.
 Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 

personnel.
 Otherwise, this could result in electric shock or fire.

Do not forcefully pull the paper out during printing.  
 It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 

 You may be burned.

Be careful not to put your hand between the machine 
and paper tray.

 You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 

 It can cause damage to the machine.

Do not block or push objects into the ventilation opening.
 This could result in elevated component temperatures which 

can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.

 It could cause damage to the machine. 

Use care to avoid paper cuts when replacing paper or removing 
jammed paper. 

 You may get hurt.

This machine's power interception device is the power cord. 
 To switch off the power supply, remove the power cord from 

the electrical outlet. 
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INSTALLATION / MOVING

 Warning

 Caution

MAINTENANCE / CHECKING

 Caution

Do not place the machine in an area with dust, 
humidity or water leaks. 

 This could result in electric shock or fire. 

When moving the machine, turn the power off and 
disconnect all cords; then lift the machine with at 
least two people.

 The machine could fall, causing human injury or 
machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

 If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
 The machine could fall, causing human injury or machine 

damage.

Make sure you plug the power cord into a grounded electrical 
outlet.

 Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.

 If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
 This can diminish performance, and could result in electric 

shock or fire.

Use only No.26 AWGa or larger, telephone line cord, if 
necessary.

 Otherwise, it can cause damage to the machine.

a.  AWG: American Wire Gauge

Use the power cord supplied with your machine  for safe 
operation. If you are using a cord which is longer than 2 meters 
(79”) with a 140V machine, then the gauge should be 16 AWG 

or larger.
  Otherwise, it can cause damage to the machine, and could 

result in electric shock or fire.

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or achol; do not 
spray water directly into the machine. 

 This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
 Children may get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.

 You may get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 

 It can cause damage to the machine. Call a 
certified technician when the machine needs repair.
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SUPPLY USAGE

 Caution

Keep the power cable and the contact surface of the plug clean 
from dust or water.

 This could result in electric shock or fire. 

To clean and operate the machine, strictly  follow the user's 
guide provided with the machine.

 Otherwise, it can cause damage to the machine.

Do not remove any covers or guards that are fastened with 
screws. 

 The machine should only be repaired by Samsung service 
technician.

Do not disassemble the toner cartridge.
 Toner dust can be dangerous to humans.

When storing supplies such as toner cartridges, keep 
them away from children..

 Toner dust can be dangerous to humans.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.

 It can cause an explosion or fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.

 In case of  damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

 Toner dust can be dangerous to humans.
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regulatory information
This machine is designed for our sound environment and certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 825.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

TAIWAN ONLY

OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.
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PERCHLORATE WARNING

This Perchlorate warning applies only to primary CR (Manganese Dioxide) Lithium coin cells in the product sold or distributed ONLY in 
California USA. 
Perchlorate Material - special handling may apply.
See www.dtsc.ca.gov/hazardouswaste/perchlorate. (U.S.A. only)

POWER SAVER

RECYCLING

CHINA ONLY

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources. 
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.
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CORRECT DISPOSAL OF BATTERIES IN THIS PRODUCT

(Applicable in the European Union and other European countries with separate battery return systems.)

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

TAIWAN ONLY

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. 
To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your 
local, free battery return system.
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RUSSIA ONLY

AE95AE95

FAX BRANDING

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device to send any 
message via a telephone facsimile machine unless such message clearly contains in a margin at the top or bottom of each transmitted page or 
on the first page of the transmission the following information:
1. the date and time of transmission
2. identification of either business, business entity or individual sending the message; and
3. telephone number of either the sending machine, business, business entity or individual.
The Telephone Company may make changes in its communications facilities, equipment operations or procedures where such action is
reasonably required in the operation of its business and is not inconsistent with the rules and regulations in FCC Part 68. If such changes can 
be reasonably expected to render any customer terminal equipment incompatible with telephone company communications facilities, or require 
modification or alteration of such terminal equipment, or otherwise materially affect its use or performance, the customer shall be given 
adequate notice in writing, to allow the customer an opportunity to maintain uninterrupted service

RINGER EQUIVALENCE NUMBER

The Ringer Equivalence Number and FCC Registration Number for this machine may be found on the label located on the bottom or rear of the 
machine. In some instances you may need to provide these numbers to the telephone company.
The Ringer Equivalence Number (REN) is a measure of the electrical load placed on the telephone line, and is useful for determining whether 
you have “overloaded” the line. Installing several types of equipment on the same telephone line may result in problems making and receiving 
telephone calls, especially ringing when your line is called. The sum of all Ringer Equivalence Numbers of the equipment on your telephone 
line should be less than five in order to assure proper service from the telephone company. In some cases, a sum of five may not be usable on 
your line. If any of your telephone equipment is not operating properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.
The equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the rear of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the 
telephone company.

FCC Regulations state that changes or modifications to this equipment not expressly approved by the manufacturer could void the user’s 
authority to operate this equipment. In the event that terminal equipment causes harm to the telephone network, the telephone company 
should notify the customer that service may be stopped. However, where prior notice is impractical, the company may temporarily cease 
service, providing that they:
a) promptly notify the customer.
b) give the customer an opportunity to correct the equipment problem.
c) inform the customer of the right to bring a complaint to the Federal Communication Commission pursuant to procedures set out in

FCC Rules and Regulations Subpart E of Part 68.
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You should also know that:
• Your machine is not designed to be connected to a digital PBX system.
• If you intend to use a computer modem or fax modem on the same phone line as your machine, you may experience transmission and 

reception problems with all the equipment. It is recommended that no other equipment, except for a regular telephone, share the line with 
your machine.

• If your area experiences a high incidence of lightning or power surges, we recommend that you install surge protectors for both the power 
and the telephone lines. Surge protectors can be purchased from your dealer or telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give you further instructions on how to actually test the emergency 
number.

• This machine may not be used on coin service or party lines.
• This machine provides magnetic coupling to hearing aids.
You may safely connect this equipment to the telephone network by means of a standard modular jack, USOC RJ-11C.

REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 

• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

You must earth this machine.
The wires in the mains lead have the following color code:
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DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without
5. Prior written permission. For written permission, please contact openssl-core@openssl.org.
6. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
7. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:



Regulatory information_ 19

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library 
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an 
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  
IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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EU DECLARATION OF CONFORMITY
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CHINA ONLY
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about this user’s guide
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each 
step during actual usage. Valuable for both novice and professional users can refer to this as a guide for installing and 
using the machine.

• Read the safety information before using the machine.
• If you have a problem using the machine, refer to the troubleshooting chapter. (See "Troubleshooting" on page 90.)
• Terms used in this user’s guide are explained in the glossary chapter. (See "Glossary" on page 112.)
• Use Index to find information.
• All illustrations in this user’s guide may differ from your machine depending on its options or models.
• The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

The date format may differ from country 
to country.

Do not touch the green underside of the 
toner cartridge. 

CONVENTION DESCRIPTION EXAMPLE

Bold For texts on the display or button names on the machine. Start

Note Provides additional information or detailed specification of the machine function 
and feature.

Caution Gives users information to protect the machine from possible mechanical 
damage or malfunction.

Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for the additional detailed information. (See Finding more information.)



About this user’s guide_ 23

FINDING MORE INFORMATION
You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

MATERIAL NAME DESCRIPTION

Quick Install Guide This guide provides information on setting up your machine and this requires that you follow the instructions in the guide to prepare the 
machine.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining 
your machine, troubleshooting, and installing accessories. 

Network Website If you have network model, you can set the network environment from your computer using network-managing programs, such as 
SetIP, SyncThruTM Web Admin Service, AnyWeb Print etc. SyncThruTM Web Admin Service will be convenient for network 
administrators who need to manage many machines simultaneously. AnyWeb Print helps personal users to screen-capture the 
website screen in Windows Internet Explorer easily. You can download the SyncThruTM Web Admin Service or AnyWeb Print on 
http://solution.samsungprinter.com. SetIP program is provided in the software CD.

Machine Driver Help This help provides you with help information on printer driver and instructions for setting up the options for printing. (See "Using help" 
on page 55.)

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website, 
www.samsungprinter.com.
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

Print with excellent quality and speed

Handle many different types of printable material

Create professional documents

Save time and money

Print in various environments

• You can print with a resolution of up to 1200 x 600 dpi 
effective output.

• Your machine prints A4-sized paper at up to 22 ppm and 
letter-sized paper at up to 23 ppm.

• Manual tray supports plain paper in various sizes, letterhead, 
envelopes, labels, custom-sized media, postcards, and 
heavy paper.

• The 250-sheet tray supports plain paper.

• Print Watermarks. You can customize your documents with 
words, such as “Confidential”. (See "Using watermarks" on 
page 57.)

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. (See 
"Printing posters" on page 56.)

• You can use preprinted forms with plain paper. (See"Using 
overlay" on page 57.)

• To save paper, you can print multiple pages on one single 
sheet of paper. (See "Printing multiple pages on one sheet of 
paper" on page 55.)

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(manual). (See "Printing on both sides of paper (Manual)" on 
page 56.)

• You can print with various operating system such as 
Windows, Linux and Macintosh systems. (See "System 
requirements" on page 32.)

• Your machine is equipped with a USB interface and a 
network interface.

Copy originals in several formats

Scan the originals and send it right away

Set a specific time to transmit a Fax

IPv6

• Your machine can copy multiple image copies from the 
original document on a single page. (See "2-up or 4-up 
copying (N-up)" on page 63.)

• The print quality and image size may be adjusted and 
enhance at the same time.

• Scan in color and use the precise compressions of JPEG, 
TIFF and PDF formats.

• Quickly scan and send files to multiple destinations using 
Networks scanning. (See "For network connected machine" 
on page 65.)

• You can specify a certain time to transmit the fax and also 
send the fax to several stored destinations.

• After the transmission, the machine may print out the fax 
reports according to the setting.

This machine supports IPv6.
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FEATURES BY MODELS
The machine is designed to support all of your document needs from printing and copying to more advanced networking solutions for your business. 
Some features and optional goods may not be available depending on models or countries.
Features by models include:

( : Included, : Optional, Blank: Not available) 

FEATURES SCX-4600(K) SCX-4623F(K) SCX-4623FN SCX-4623FH(K)

USB 2.0

Network Interface Ethernet 10/100 Base TX wired LAN

IPv6

Print

Copy

Scan feature ID copy, clone, poster copy, auto fit

2/4 up

FAX

Duplex (2-sided) printing (manual)

Print Screen

Reduce/Enlarge

On hook dial

Document Feeder

Scanner glass

Handset

SyncThru™Web Service

SetIP program

Network PC fax
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2.introduction
This chapter gives you an overview of your machine:
This chapter includes:
• Machine overview
• Control panel overview (SCX-4623 Series)
• Control panel overview (SCX-4600 Series)
• Understanding the Status LED
• Control panel overview (SCX-4600 Series)
• Turning on the machine

MACHINE OVERVIEW
Front view

This illustration may differ from your machine depending on its model.

1 6 11 16

2 7 12 17

3 8 13

4 9 14

5 10 15

Document feeder covera Front door handle Document output tray Scanner glass

Document feeder width 
guidesa Handle Control panel Handsetb

Document feeder input traya Tray 1 Toner cartridge

Document feeder output traya Manual tray Manual tray paper width 
guides

Output support Front door Scanner lid
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Rear view

This illustration may differ from your machine depending on its model.

1 5

2 6

3 7

4

a.SCX-4623F(K), SCX-4623FN, SCX-4623FH(K)
b.SCX-4623FH(K) only.

Network porta

a.SCX-4623FN

Power receptacle

USB port Rear door

Telephone line socketb

b.SCX-4623F(K), SCX-4623FN, SCX-4623FH(K)

Rear door handle

Extension telephone socket 
(EXT)b
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CONTROL PANEL OVERVIEW (SCX-4623 SERIES)

1

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

ID Copy You can copy both sides of the ID Card like a driver’s license to a single side of paper. (See "ID card copying" on page 63.)

2 Print screen Prints the active screen displayed on the monitor. (See "Print screen button" on page 30.)
(SCX-4623F(K), SCX-4623FH(K) only)

Reduce/Enlarge Makes a copy smaller or larger than the original. (SCX-4623FN only)

Display Shows the current status and prompts during an operation.

Status Shows the status of your machine. (See "Understanding the Status LED" on page 30.)

 (Fax) Activates fax mode.

 (Copy) Activates copy mode.

 (Scan) Activates scan mode.

Arrow Scroll through the options available in the selected menu, and increase or decrease values.

Menu Enters Menu mode and scrolls through the available menus. (See "Machine status and advanced feature" on page 77.)

OK Confirms the selection on the screen.

Back Sends you back to the upper menu level.

Numeric keypad Dials fax number, and enters the number value for document copies or other options.

Address Book Allows you to store frequently used fax numbers and email addresses or search for stored fax numbers or email addresses.

Redial/Pause In standby mode, redials the last number. Also in edit mode, inserts a pause into a fax number.

On Hook Dial Performs same as you hold a handset under the telephone line is engaged.

Start Starts a job.

Stop/Clear Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or 
resume.

 (Power) Sends the machine into power saver mode. If you press and hold this button, you can also turn the power on and off. (See 
"(Power button)" on page 30.)
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CONTROL PANEL OVERVIEW (SCX-4600 SERIES)

1

2

3

4

5

6

7

8

9

10

11

12

Display Shows the current status and prompts during an operation.

Status Shows the status of your machine. (See "Understanding the Status LED" on page 30.)

Arrow Scroll through the options available in the selected menu, and increase or decrease values.

Menu Enters Menu mode and scrolls through the available menus. (See "Machine status and advanced feature" on page 77.)

OK Confirms the selection on the screen.

Back Sends you back to the upper menu level.

ID Copy You can copy both sides of the ID Card like a driver’s license to a single side of paper. (See "ID card copying" on page 63.)

Scan to Sends scanned data. (See "Scanning originals and sending to your computer (Scan to PC)" on page 65.)

Print screen Prints the active screen displayed on the monitor. (See "Print screen button" on page 30.)

Stop/Clear Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or 
resume.

Start Starts a job.

 (Power) Sends the machine into power saver mode. If you press and hold this button, you can also turn the power on and off. (See 
"(Power button)" on page 30.)
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UNDERSTANDING THE STATUS LED

• The machine is off-line.
• The machine is in power saver mode. When 

data is received, or any button is pressed, it 
switches to on-line automatically.

• When the backlight slowly blinks, the machine 
is receiving data from the computer.

• When the backlight blinks rapidly, the 
machine is printing data. 

• A minor error has occurred and the machine is 
waiting for the error to be cleared. Check the 
display message. When the problem is 
cleared, the machine resumes. 

• Small amount of toner is left in the cartridge. 
The estimated cartridge lifea

a.Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19752. (See "General specifications" on 
page 105.) The number of pages may be affected by operating 
environment, printing interval, media type, and media size. Some 
amount of toner may remain in the cartridge even when Toner Empty
appears and the printer stops printing.

• A toner cartridge has almost reached its 
estimated cartridge lifea. It is recommended to 
replace the toner cartridge. (See "Replacing 
the toner cartridge" on page 103.)

• A paper jam has occurred. (See "Clearing 
paper jams" on page 92.)

• The cover is opened. Close the cover.
• There is no paper in the tray. Load paper in 

the tray.
• The machine has stopped due to a major 

error. Check the display message. (See 
"Understanding display messages" on 
page 94.)

 of toner is close. 
Prepare a new cartridge for replacement. You 
may temporarily increase the printing quality 
by redistributing the toner. (See 
"Redistributing toner" on page 90.)

The color of the status LED indicates the machine's current status.

Check the message on the display. Follow the instructions in the 
message or refer to troubleshooting part. (See "Understanding display 
messages" on page 94.) If the problem persists, call for service.

INTRODUCING THE USEFUL BUTTONS
Menu button
When you want to know the machine status and set your machine to use an 
advanced feature, click Menu button. (See "Machine status and advanced 
feature" on page 77.)

(Power button)
When the machine is not in use, save electricity by pressing the 
(power) button. Pressing this button for one second puts the machine into 
power save mode. (See "Using the save modes" on page 45.)
When you want to turn the power off, press this button until Power Down
appear. Choose Yes, to turn the power off. This button can also be used to 
turn the machine on.

• The machine is in ready mode.
• The machine’s power is off.

Print screen button
Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

If you press Print Screen button for more than two seconds, machine prints 
active screen displayed on the monitor, if you press Print Screen button for 
less than two seconds, machine prints the whole screen displayed in the 
monitor. The page will be printed on the default page like A4, Letter.

• You can only use this function with USB-connect machine. 
• Print Screen can only be used in the Windows and Macintosh.
• You can only use this function if the machine driver is installed.

TURNING ON THE MACHINE
1. Plug in the power cord.

2. Press the  (power) button.

If you want to turn the power off, press this button until Power Down
appear. 

STATUS DESCRIPTION

Off

Green Blinking

On The machine is on-line and can be used.

Red Blinking

On

STATUS DESCRIPTION

Off

On The machine is in power save mode.
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3.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.
This chapter includes:
• Setting up the hardware
• Supplied software
• System requirements

• Installing USB connected machine’s driver
• Sharing your machine locally

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware, as is explained in the 
Quick Install Guide. Make sure you read the Quick Install Guide first and 
follow the steps below:
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing. (See "Altitude adjustment" on 
page 43.)
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 mm (0.08 inch). Otherwise, printing quality may be 

affected.

2. Unpack the machine and check all the enclosed items.
3. Remove all the tapes.
4. Install the toner cartridge.
5. Load paper. (See "Loading paper in the tray" on page 49.)
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

This equipment will be inoperable when mains power fails.

SUPPLIED SOFTWARE
After you have set up your machine and connected it to your computer., you 
must install the printer and scanner software using the supplied CD . The 
software CD provides you with the following software.



• Printer driver: Use this driver to take full advantage of 
your machine’s features.

• Scanner driver: TWAIN and Windows Image 
Acquisition (WIA) drivers are available for scanning 
documents on your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SmarThrua:

a.Allows you to edit a scanned image in various ways using a powerful 
image editor and to send the image by email. You can also open 
another image editor program, such as Adobe Photoshop, from 
SmarThru . For details, refer to the on screen help supplied on the 
SmarThru program. (See "Smarthru" on page 83.)

• Printer driver: Use this driver to take full advantage of 
your machine’s features.

• Scanner driver: TWAIN driver is available for 
scanning documents on your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Samsung Scan & Fax Manager: You can find out 
about Scan & Fax Manager program information and 
installed scan driver's condition.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

• Unified Linux Driver: Use this driver to take full 
advantage of your machine’s features.

• SANE: Use this driver to scan documents.
• Smart Panel: This program allows you to monitor the 

machine’s status and alerts you when an error occurs 
during printing.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

This program is the accompanying 
Windows-based software for your multifunctional 
machine. 

• Samsung Scan & Fax Manager: You can find out 
about Scan & Fax Manager program information and 
installed scan driver's condition.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.
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SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems.

• Internet Explorer 5.5 or higher is the minimum requirement for all 
Windows operating systems.

• Users who have an administrator right can install the software.
• Windows Terminal Services is compatible with this machine.

Macintosh

• Intel 
Processors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

• Intel 
Processors

• 867 MHz or 
faster Power 
PC G4/ G5

Linux

OS CONTENTS

Windows

Macintosh

Linux

OPERATING
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 
2000

Pentium II 400 MHz 
(Pentium III 933 MHz)

64 MB  
(128 MB)

600 MB

Windows XP Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB  
(256 MB)

1.5 GB

Windows 
Server 2003

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB  
(512 MB)

1.25 GB to  
2 GB

Windows 
Vista

Pentium IV 3 GHz 512 MB  
(1024 MB)

15 GB

Windows 
Server 2008

Pentium IV 1 GHz 
(Pentium IV 2 GHz)

512 MB  
(2048 MB)

10 GB

OPERATING
SYSTEM

REQUIREMENTS (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Mac OS X 
10.3 ~ 10.4

1 GB

Mac OS X 
10.5 ~ 10.6

512 MB (1 GB) 1 GB

ITEM REQUIREMENTS

Operating 
system

RedHat 8.0, 9.0 (32bit)
RedHat Enterprise Linux WS 4, 5 (32/64bit)
Fedora Core 1~7 (32/64bit)
Mandrake 9.2 (32bit), 10.0, 10.1 (32/64bit)
Mandriva 2005, 2006, 2007 (32/64bit)
SuSE Linux 8.2, 9.0, 9.1 (32bit)
SuSE Linux 9.2, 9.3, 10.0, 10.1, 10.2 (32/64bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64bit)
Ubuntu 6.06, 6.10, 7.04 (32/64bit)
Debian 3.1, 4.0 (32/64bit)

CPU Pentium IV 2.4GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2GB)
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• It is necessary to claim swap partition of 300 MB or larger for 
working with large scanned images.

• The Linux scanner driver supports the optical resolution at 
maximum.

INSTALLING USB CONNECTED MACHINE’S 
DRIVER
A locally connected machine is a machine directly attached to your 
computer using the USB cable. If your machine is attached to a network, 
skip the following steps below and go on to installing network connected 
machine’s driver. (See "Installing wired network or USB connected 
machine’s driver" on page 39.)

• Selecting Custom installation allows you to choose programs to 
install.

• Only use an USB cable no longer then 3 m (118 in.).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a 
machine directly connected to your computer. All components necessary for 
machine operations will be installed.
1. Make sure that the machine is connected to your computer and powered 

on.
If the “New Hardware Wizard” window appears during the 
installation procedure, click  in the upper right corner of the box 
to close the window, or click Cancel.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appear.
• If the installation window does not appear, click Start and then Run.

Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Select Install Now.

If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

The program searches the machine.
If your machine is not connected to the computer, the following 
window will appear.

• After connecting the machine, click Next.
• If you don't want to connect the machine at this time, click the 

check box beside of Check if you want to install the 
software without connecting the printer to the network or 
locally.. In this case, the print a test page window will be 
skipped, and completes the installation.

• The installation window in this User’s Guide may differ 
depending on the machine and interface in use.

5. When the printer connection confirmation window appears, check the 
printer name and click Next.

6. After the installation is finished, a window asking you to print a test page 
appears. If you choose to print a test page, click the button and Next.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.
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8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration. You are now registered to the 
Samsung web site.

9. Click Finish.
If the printer driver does not work properly, follow the steps below to 
repair or reinstall the driver. 
a) Make sure that the machine is connected to your machine and 

powered on.
b) From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > Maintenance.
c) Select the option as you wish, follow the instruction on the window.

Macintosh
The software CD that came with your machine provides you with the Driver 
files that allows you to use the CUPS driver or PostScript driver (only 
available when you use a machine which supports the PostScript driver) for 
printing on a Macintosh computer. 
Also, it provides you with the TWAIN driver for scanning on a Macintosh 
computer.
1. Make sure that the machine is connected to your computer and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

9. When the message which warns that all applications will close on your 
computer appears, click Continue.

10. After the installation is finished, click Quit.
If you have installed scan driver, click Restart.

11. Open the Applications folder > Utilities > Print Setup Utility.
• For Mac OS X 10.5 ~ 10.6, open the Applications folder > System 

Preferences and click Print & Fax.
12. Click Add on the Printer List.

• For Mac OS X 10.5 ~ 10.6, press the “+” icon; a display window will 
pop up. 

13. For Mac OS X 10.3, select the USB tab. 
• For Mac OS X10.4, click Default Browser and find the USB 

connection.
• For Mac OS X 10.5 ~ 10.6, click Default and find the USB 

connection.
14. For Mac OS X 10.3, if Auto Select does not work properly, select 

Samsung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model.
• For Mac OS X 10.5 ~ 10.6, if Auto Select does not work properly, 

select Select a driver to use... and your machine name in Print
Using.

Your machine appears on the Printer List, and is set as the default 
machine.

15. Click Add.
If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 

powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall.
i) When the message which warns that all applications will close on 

your computer appears, click Continue.
j) When the uninstall is done, click Quit.

Linux
Follow the steps below to install the driver for Linux. While installing the 
driver, the Unified Linux Driver package will automatically be installed as 
well. 

The supplied software CD provides you with the Unified Linux Driver 
package for using your machine with a Linux computer easily in UI 
based management tool.(See "Using the Linux Unified Driver 
Configurator" on page 84.)

1. Make sure that the machine is connected to your computer and powered 
on.

2. When the Administrator Login window appears, type in root in the 
Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. Insert the supplied software CD into your CD-ROM drive.
The software CD will run automatically.

If the software CD does not run automatically, click the  icon at the 
bottom of the desktop. When the Terminal screen appears, type in the
following:
If the software CD is secondary master and the location to mount is 
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/mnt/cdrom,
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost Linux]#./install.sh
If you still failed to run the software CD type the followings in sequence:
[root@localhost root]#umount /dev/hdc
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom

The installation program runs automatically if you have an autorun 
software package installed and configured.

4. When the welcome screen appears, click Next.

5. When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator desktop 
icon and the Unified Driver group to the system menu for your convenience. 
If you have any difficulties, consult the on screen help that is available 
through your system menu or can otherwise be called from the driver 
package Windows applications, such as Unified Driver Configurator or 
Image Manager.

Installing the driver in the text mode:
• If you do not use the graphical interface or have been unable to 

install the driver, you have to use the driver in the text mode.
• Follow the steps 1 to 3, then type [root@localhost Linux]# 

./install.sh. Follow the instructions on the terminal screen. The 
installation is completed.

• When you want to uninstall the driver, follow the installation 
instructions above, but type [root@localhost Linux]# ./uninstall.sh 
on the terminal screen.

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below steps to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and 

powered on.
b) When the Administrator Login window appears, type in root in the 

Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer driver. 
If you are not a super user, ask your system administrator.

c) Insert the supplied software CD into your CD-ROM drive.
The software CD will run automatically.
If the software CD does not run automatically, click the  icon at 
the bottom of the desktop. When the Terminal screen appears, 
type in:
If the software CD is secondary master and the location to mount 
is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost Linux]#./uninstall.sh
The installation program runs automatically if you have an autorun 
software package installed and configured.

d) Click Uninstall.
e) Click Next.
f) Click Finish.

SHARING YOUR MACHINE LOCALLY

1

2

Follow the steps below to set up the computers to share your machine 
locally.
If the Host computer is directly connected to the machine with USB cable 
and is also connected to the local network environment, the client computer 
connected to the local network can use the shared machine through the 
host computer to print. 

Windows
Setting up a host computer
1. Install your printer driver. (See "Installing USB connected machine’s 

driver" on page 33.)
2. Click the Windows Start menu. 
3. For Windows 2000, select Settings > Printers.

• For Windows XP/2003 select Printer and Faxes.
• For Windows 2008/Vista select Control Panel > Hardware and 

Sound > Printers.
4. Double-click your printer driver icon. 
5. From the Printer menu, select Sharing....
6. Check the Share this printer.
7. Fill in the Shared Name field. Click OK.

Setting up a client computer
1. Install your printer driver. (See "Installing USB connected machine’s 

driver" on page 33.)
2. Click the Windows Start menu. 
3. Select All programs > Accessories > Window Explorer.
4. Enter in IP address of the host computer and press Enter in your 

keyboard. 

Host computer A computer which is directly connected to 
the machine by USB cable.

Client computers Computers which use the machine shared 
through the host computer. 
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In case host computer requires User name and Password, fill 
in User ID and password of the host computer account.

5. Right click the printer icon you want to share and select Connect.
6. If a set up complete message appears, click OK.
7. Open the file you want to print and start printing. 

Macintosh
The following steps are for Mac OS X 10.5 ~ 10.6. Refer to Mac Help 
for other OS versions. 

Setting up a host computer
1. Install your printer driver. (See "Macintosh" on page 34)
2. Open the Applications folder > System Preferences and click 

Print & Fax.
3. Select the printer to share in the Printers list.
4. Select “Share this printer”.

Setting up a client computer
1. Install your printer driver. (See "Macintosh" on page 34.)
2. Open the Applications folder > System Preferences and click 

Print & Fax.
3. Press the “+” icon. 

A display window showing the name of your shared printer appears.
4. Select your machine and click Add.
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4.network setup
This chapter gives you step-by-step instructions for setting up the network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs

• Using a wired network
• IPv6 Configuration

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

NETWORK ENVIRONMENT

• Ethernet 10/100 Base-TX

• Windows 2000/XP/2003/2008/Vista
• Various Linux OS
• Mac OS X 10.3 ~ 10.6

• TCP/IPv4
• DHCP, BOOTP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing(RAW), LPR, 

IPP
• SNMPv 1/2/3, HTTP(S), IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP(S), IPSec
(See "IPv6 Configuration" on page 42.)

You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.
The following table shows the network environments supported by the 
machine:

INTRODUCING USEFUL NETWORK PROGRAMS
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible. 

Before using the programs below, set the IP adress first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to:
• Configure the network parameters necessary for the machine to connect 

to various network environments.
• Customize machine settings.

(See "Using SyncThru™ Web Service" on page 82.)

SyncThru™ Web Admin Service
Web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

AnyWeb Print
This tool helps you to screen-capture, preview, scrap and print the screen of 
Windows Internet Explorer more easily, than when you use the ordinary 
program. Click Start > All programs > Samsung Printers > your machine 
name > AnyWeb Print to link the website where the tool is available for the 
download. This tool is available only for Windows operating systems.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol. (See "IP setting 
using SetIP Program (Windows)" on page 38 or "IP setting using SetIP 
Program (Macintosh)" on page 38.)

TCP/IPv6 is not supported by this program.

USING A WIRED NETWORK
You must set up the network protocols on your machine to use it on your 
network. This chapter will show you how this is easily accomplished.
You can use network after connecting network cable to a corresponding 
port on your machine. 

Printing Network Configuration report
You can print a Network Configuration Report from the machine’s control 
panel that will show the current machine’s network settings. This will help 
you to set up a network and troubleshooting problems.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until Network Info. appear and press OK.
Using this Network Configuration Report, you can find your machine MAC 
address and IP address.
For example:
• MAC Address : 00:15:99:41:A2:78
• IP Address : 192.0.0.192

ITEM REQUIREMENTS

Network interface

Network operating system

Network protocols
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Setting IP address
Firstly, you have to set up an IP address for network printing and 
managements. In most cases a new IP address will be automatically 
assigned by a DHCP (Dynamic Host Configuration Protocol) server located 
on the network.
In a few situations the IP address must be set manually.  This is called a 
static IP and is often required in corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 
report.

• Static IP assignment: Use SetIP program to change the IP address 
from your computer. If your machine has a control panel, you can also 
change IP address using the machine's control panel.

In an office environment, we recommend that you contact a network 
administrator to set this address for you.

IP setting using control panel
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. Press Menu on the control panel.
4. Press the left/right arrow until Network appear and press OK.
5. Press the left/right arrow until TCP/IP (IPv4) appear and press OK.
6. Press the left/right arrow until IPv4 Activate appear and press OK.
7. Press the left/right arrow until On appear and press OK.

On is set as a default.

8. Press the left/right arrow until Set IP Address appear and press OK.
9. Press the left/right arrow until Manual appear and press OK.
10. The first available menu item, IP Address displays.

• Enter a number between 0 and 255.
11. Enter the IP address using numeric keypad appear and press OK.
12. Enter other parameters, such as the Subnet Mask and Gateway

appear and press OK.
13. After entering all parameters, press Stop/Clear to return to ready 

mode.
Now go to "Installing wired network or USB connected machine’s driver" 
on page 39.

IP setting using SetIP Program (Windows)
This program is for manually setting the network IP address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Network Configuration Report.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:
1. Open Control Panel.
2. Double click Security Center.
3. Click Windows Firewall.
4. Disable the firewall.

Installing the program
1. Insert the Printer Software CD-ROM provided with your machine. 

When the driver CD runs automatically, close that window.
2. Start Windows Explorer and open the X drive. (X represents your 

CD-ROM drive.)

3. Double-click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK. If necessary, select a language from the drop-down list.
6. Follow the instructions in the window and complete the installation.

Starting the program
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.

4. Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window 
as follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.

• MAC Address : Find the machine’s MAC address from the 
Network Configuration Report and enter it without the colons. 
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

• IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

• Subnet Mask: Enter a Subnet Mask.
• Default Gateway: Enter a Default Gateway.

6. Click Apply, and then click OK. The machine will automatically print 
the Network Configuration Report. Confirm that all the settings are 
correct.

7. Click Exit to close the SetIP program.
8. If necessary, restart the computer’s firewall.

IP setting using SetIP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing 
by performing the following:
1. Open System Preferences.
2. Click Security.
3. Click the Firewall menu.
4. Turn firewall off.

The following instructions may vary for your model.

1. Connect your machine to the network with a network cable.
2. Insert the Installation CD-ROM, and open the disk window, select 

MAC_Installer > MAC_Printer > SetIP > SetIPapplet.html.
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3. Double click the file and Safari will automatically open, then select 
Trust. The browser will open the SetIPapplet.html page that shows 
the printer’s name and IP address information. 

4. Highlight the printer information row and select the Setup icon,
which is the second icon from the left in the application menu bar. A 
TCP/IP Configuration window will open.

If the printer was not shown in the information row, select the 
Manual Setting icon (third from left) to open the TCP/IP 
Configuration window.

5. Enter the machine’s new information into the configuration window 
as follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.
• MAC Address : Find the machine’s MAC address from the 

Network Configuration Report and enter it without the colons. 
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

• IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

• Subnet Mask: Enter a Subnet Mask.
• Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all the settings are correct. 
Quit Safari. You may close and eject the installation CD-ROM. If 
necessary, restart the computer’s firewall. You have successfully 
changed the IP address, subnet mask, and gateway.

IP setting using SetIP Program (Linux)
SetIP program should be automatically installed during the printer driver 
installation.
1. Print the machine’s network configuration report to find your 

machine’s MAC address. 
2. Open the /opt/Samsung/mfp/share/utils/.
3. Double click the SetIPApplet.html file. 
4. Click to open the TCP/IP configuration window. 
5. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

6. The machine prints the network information. Confirm all the settings 
are correct. 

7. Close the SetIP program. 

Network parameter setting
You can also set up the various network settings through the network 
administration programs such as SyncThru™ Web Admin Service and 
SyncThru™ Web Service.

Restoring factory default settings
You may need to reset the machine to the factory default settings when 
machine that you are using is connected to new network environment.

Restoring factory default settings using control panel
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until Clear Settings appear and press OK.
4. Turn off and restart machine to apply settings.

Restoring factory default settings using SyncThru™ 
Web Service
1. Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example,

2. When the SyncThru™ Web Service window opens, click Network 
Settings.

3. Click Reset. Then, click Clear for network.

4. Turn off and restart machine to apply settings.

INSTALLING WIRED NETWORK OR USB 
CONNECTED MACHINE’S DRIVER
Windows
You can set up the machine driver, follow the steps below. 
This is recommended for most users. All components necessary for 
machine operations will be installed. 
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation window 
appear.

• If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.
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3. Select Install Now.

If necessary, select a language from the drop-down list.
The Advanced Installation has two options, Custom Installation
and Install Software Only. The Custom Installation allows you to 
select the machine’s connection and choose individual component 
to install. The Install Software Only allows you to install the 
supplied softwares, such as Smart Panel. Follow the instruction on 
the window.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

The program searches the machine.
If your machine is not found in the network or locally, the following 

window will appear.

• Check if you want to install the software without 
connecting the printer to the network or locally.
- Check this option to install this program without a machine 

connected. In this case, the print a test page window will be 
skipped, and completes the installation.

• Search again
When you press this button, the firewall notice window 
appears;
- Turn off the firewall and Search again. For Window 

operating system, click Start > Control Panel > Windows 
Firewall, and inactivate this option.

- Turn off the firewall from the third party's program beside 
the operating system. Refer to the manual provided by 
individual programs.

• Direct Input
The Direct Input allows you to search a specific machine on 
the newtwork.
- Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report. (See "Installing wired network or USB 
connected machine’s driver" on page 39.)

- Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

• Help
If your machine is not connected to the computer or network, 
This help button gives detailed information about the how to 
connect the machine.

• Set IP Address
If you want to set a specific IP address on a specific network 
machine, click the Set IP Address button. The Set IP Address
window appears. Do as follows:
a) Select a machine to be set with a specific IP address from 

the list.
b) Configure an IP address, subnet mask, and gateway for the 

machine manually and click Apply to set the specific IP 
address for the network machine.

c) Click Next.
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5. The searched machine will be shown on the screen. Select one you wish 
to use.

If the driver searched only one printer, the confirmation window 
appears.

The program starts installation.
6. After the installation is finished, a window asking you to print a test page 

appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 7.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration. You are now registered to the 
Samsung web site.

9. Click Finish.
• After the driver setup, you may enable firewalls.
• If your printer driver doesn’t work properly after setup has been 

completed, repair or reinstall the printer driver. (See "Installing 
USB connected machine’s driver" on page 33.)

Macintosh
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the network key and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

9. When the message which warns that all applications will close on your 
computer appears, click Continue.

10. Select Typical installation for a network print and click OK.
The certificate window appears, click Trust. (See "Macintosh" on 
page 84 to use SetIP program.)

11. After the installation is finished, click Quit.

12. Open the Applications folder > Utilities > Print Setup Utility.
• For Mac OS X 10.5 ~ 10.6, open the Applications folder > System 

Preferences and click Print & Fax.
13. Click Add on the Printer List.

• For Mac OS X 10.5 ~ 10.6, press the “+” icon; a display window will 
pop up. 

14. For Mac OS X 10.3, select the IP Printing tab.
• For Mac OS X 10.4, click IP Printer.
• For Mac OS X 10.5 ~ 10.6, click IP.

15. Select Socket/HP Jet Direct in Printer Type.
When printing a document containing many pages, printing performance 
may be enhanced by choosing Socket for Printer Type option.

16. Enter the machine’s IP address in the Printer Address field.
17. Enter the queue name in the Queue Name field. If you cannot determine 

the queue name for your machine server, try using the default queue 
first.

18. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model Name.
• For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model.
• For Mac OS X 10.5 ~ 10.6, if Auto Select does not work properly, 

choose Select a driver to use... and your machine name in Print
Using.

Your machine’s IP address appears on the Printer List, and is set as 
the default machine.

19. Click Add.
If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a) Make sure that the machine is connected to your computer and 

powered on.
b) Insert the supplied software CD into your CD-ROM drive.
c) Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the network key and click OK.
g) The Samsung Installer window opens. Click Continue.
h) Select Uninstall and click Uninstall.
i) When the message which warns that all applications will close on 

your computer appears, click Continue.
j) When the uninstall is done, click Quit.

Linux
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click CD-ROM icon that appears on your Linux desktop.
4. Double-click the Linux folder.
5. Double-click the install.sh icon.
6. The Samsung Installer window opens. Click Continue.
7. The Add printer wizard window opens. Click Next.
8. Select Network printer and click Search button.
9. The Printer’s IP address and model name appears on list field.
10. Select your machine and click Next.
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IPV6 CONFIGURATION
TCP/IPv6 is supported properly only in Windows Vista or higher.

If the IPv6 network seems not working, set all the network setting to 
the factory defaults and try again. (See "Restoring factory default 
settings" on page 39.)

To use the IPv6 network environment, follow the next procedure to use the 
IPv6 address:
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. Print a Network Configuration Report from the machine’s control 

panel that will check IPv6 addresses.

a) Press Menu on the control panel.
b) Press the left/right arrow until Network appear and press OK.
c) Press the left/right arrow until Network Info. appear and press 

OK.
4. Select Start > Control Panel > Hardware and Sound > Printers > Add 

Printer.
5. Click Add a local printer on the Add Printer windows.
6. Follow the instruction on the window.

If the machine does not work in the network environment, activate 
IPv6. Refer to the next section followed by.

Activating IPv6
The machine is provided with IPv6 feature on.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until TCP/IP (IPv6) appear and press OK.
4. Press the left/right arrow until IPv6 Activate appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Turn the machine off and turn it on again.
7. Reinstall your printer driver.

Setting IPv6 addresses
Machine supports following IPv6 addresses for network printing and 
managements.
• Link-local Address: Self-configured local IPv6 address. (Address starts 

with FE80.)
• Stateless Address: Automatically configured IPv6 address by a 

network router.
• Stateful Address: IPv6 address configured by a DHCPv6 server.
• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the 
following option for default dynamic host configuration:
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until TCP/IP (IPv6) appear and press OK.
4. Press the left/right arrow until DHCPv6 Config appear and press 

OK.
5. Press the left/right arrow to access the required value.

• Routers: Use DHCPv6 only when requested by a router.
• DHCPv6 Addresses: Always use DHCPv6 regardless of router 

request.

• DHCPv6 Off: Never use DHCPv6 regardless of router request.
6. Press OK.

Manual address configuration
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL. (See "Connecting SyncThru Web Service" on 
page 42.)

For IPv4, enter the IPv4 address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2. When the SyncThru™ Web Service window opens, click Network 
Settings.

3. Click TCP/IP.

4. Enable the Manual Address In the TCP/IPv6 section.
5. Select the Router Prefix and click the Add button, then the router 

prefix will automatically be entered into the address field. 
Enter the rest of address. (ex:3FFE:10:88:194::AAAA. “A” is the 
hexadecimal 0 through 9, A through F.)

6. Click the Apply button.

Connecting SyncThru Web Service
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL .
2. Select one of the IPv6 addresses (Link-local Address, Stateless 

Address, Stateful Address, Manual Address) from Network 
Configuration Report.

3. Enter the IPv6 addresses. (ex: http://[FE80::215:99FF:FE66:7701]) 
Address must be enclosed in '[ ]' brackets.
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5.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Altitude adjustment
• Changing the display language
• Setting the date and time
• Changing the clock mode
• Changing the default mode

• Setting sounds
• Entering characters using the number keypad
• Using the save modes
• Setting the default tray and paper
• Setting job timeout

ALTITUDE ADJUSTMENT

0

The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.
Before you set the altitude value, find the altitude where you are using the 
machine.

1. Ensure that you have installed the printer driver with the provided Printer 
Software CD. 

2. Double-click the Smart Panel icon on the Windows task bar (or 
Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.
4. Click Setting > Altitude Adjustment. Select the appropriate value from 

the dropdown list, and then click Apply.
• If your machine is connected to a network, SyncThru™ Web 

Service screen appears automatically. Click Machine Settings > 
System Setup > Machine Setup > Altitude Adj. Select the 
appropriate altitude value, and then click Apply.

• If your machine is connected via a USB cable, set the altitude in 
Altitude Adj. option on the machine’s display.

CHANGING THE DISPLAY LANGUAGE
To change the language that appears on the display, follow the steps below:
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.

4. Press the left/right arrow until Language appear and press OK.
5. Press the left/right arrow to display the language you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

SETTING THE DATE AND TIME
When you set the time and date, they are used in delay fax and delay print. 
They are printed on reports. If, however, they are not correct, you need to 
change it for the correct time being.

If the machine’s power is cut off, you need to reset the correct time 
and date once the power has been restored.

1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Date & Time appear and press OK.
5. Enter the correct time and date using left/right arrow or numeric keypad.

Month = 01 to 12,
Day = 01 to 31,
Year = requires four digits,
Hour = 01 to 12,
Minute = 00 to 59,
and you can also select AM or PM.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

CHANGING THE CLOCK MODE
You can set your machine to display the current time using either a 12-hour 
or 24-hour format.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Clock Mode appear and press OK.
5. Press the left/right arrow to select the other mode and press OK.
6. Press Stop/Clear to return to ready mode.

1 High 1
2 High 2
3 High 3
4 Normal
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CHANGING THE DEFAULT MODE
Your machine is preset to Copy mode. You can switch this default mode 
between Fax mode and Copy mode.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Default Mode appear and press OK.
5. Press the left/right arrow to select the mode you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

SETTING SOUNDS
You can control the following sounds:
• Key sound: Turns the key sound On or Off. With this option set to On, a 

tone sounds each time a key is pressed.
• Alarm Sound: Turns the alarm sound On or Off. With this option set to 

On, an alarm tone sounds when an error occurs or fax communication 
ends.

• Speaker: Turns On or Off the sounds from the telephone line through 
the speaker, such as a dial tone or a fax tone. With this option set to 
Comm. which means “Common”, the speaker is on until the remote 
machine answers.

You can adjust the volume level using On Hook Dial. If your 
machine is SCX-4623FH, you can adjust the volume level using 
the handset.

• Ringer: Adjusts the ringer volume. For the ringer volume, you can select 
Off, Low, Mid, and High.

Speaker, ringer, key sound, and alarm sound
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Sound/Volume appear and press OK.
4. Press the left/right arrow until the sound option you want appear and 

press OK.
5. Press the left/right arrow until the desired status or volume for the sound 

you have selected appears and press OK.
6. If necessary, repeat steps 4 through 5 to set other sounds.
7. Press Stop/Clear to return to ready mode.

Speaker volume
To adjust the volume using On Hook Dial:
1. Press Fax on the control panel.
2. Press On Hook Dial. A dial tone sounds from the speaker.
3. Press the left/right arrow until you hear the volume you want.
4. Press On Hook Dial to save the change and return to ready mode.
To adjust the volume using the handset (SCX-4623FH only)
1. Pick up the handset. A dial tone sounds from the earpice.
2. Press the left/right arrow until you hear the volume you want.
3. Press OK to save the change and replace the handset.

You can adjust the speaker volume only when the telephone line is 
connected.

ENTERING CHARACTERS USING THE NUMBER 
KEYPAD
As you perform various tasks, you may need to enter names and numbers. 
For example, when you set up your machine, you enter your name or your 
company’s name, and the fax number. When you store fax numbers or 
email addresses in memory, you may also enter the corresponding names.

Entering alphanumeric characters
1. When you are prompted to enter a letter, locate the button labeled with 

the character you want. Press the button until the correct letter appears 
on the display. 
For example, to enter the letter O, press 6, labeled with MNO.
Each time you press 6, the display shows a different letter, M, N, O, m, 
n, o and finally 6.
You can enter special characters, such as space, plus sign, and etc. For 
details, see the below section.

2. To enter additional letters, repeat step 1.
If the next letter is printed on the same button, move the cursor by 
pressing the left/right arrow button and then press the button labeled 
with the letter you want. The cursor will move to the right and the next 
letter will appear on the display.
You can enter a space by pressing 1 twice.

3. When you have finished entering letters, press OK.

Keypad letters and numbers

Correcting numbers or names
If you make a mistake while entering a number or name, press the left/right 
arrow button to delete the last digit or character. Then enter the correct 
number or character.

KEY ASSIGNED NUMBERS, LETTERS, OR CHARACTERS

1 @ / . ‘ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* *

# #
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Inserting a pause
With some telephone systems, you must dial an access code (9, for 
example) and listen for a second dial tone. In such cases, you must insert a 
pause in the telephone number. You can insert a pause while you are 
setting up speed dial numbers.
To insert a pause, press Redial/Pause at the appropriate place while 
entering the telephone number. A - appears on the display at the 
corresponding location.

USING THE SAVE MODES
Using toner saving feature
Toner save mode allows your machine to use less toner on each page. 
Activating this mode extends the life of the toner cartridge beyond what one 
would experience in the normal mode, but it reduces print quality.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Toner Save appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Press Stop/Clear to return to ready mode.

When PC-printing, you can also turn on or off toner save mode in 
the printer properties.

Using power saving feature
When you are not using the machine for a while, use this feature to save 
power. 
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Power Save appear and press OK.
5. Press the left/right arrow to select the time you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

SETTING THE DEFAULT TRAY AND PAPER
You can select the tray and paper you would like to keep using for printing 
job.

In the control panel
Setting the paper size
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Size appear and press OK.
5. Press the left/right arrow to select the paper tray you want and press 

OK.
6. Press the left/right arrow to select the paper size you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

Setting the paper type
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.

3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Type appear and press OK.
5. Press the left/right arrow to select the paper tray you want and press 

OK.
6. Press the left/right arrow to select the paper type you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

Setting the paper source
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Source appear and press OK.
5. Press the left/right arrow until Copy Tray or Fax Tray appear and 

press OK.
6. Press the left/right arrow to select the paper tray you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

Setting the wide A4
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Wide A4 appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Press Stop/Clear to return to ready mode.

In the computer
Windows
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings >Printers .

• For Windows XP/2003 select Printer and Faxes.
• For Windows Vista select Control Panel > Hardware and 

Sound > Printers.
3. Right-click your machine and press Printing Preferences.
4. Click Paper tab. 
5. Select tray and its options, such as paper size and type.
6. Press OK.

Macintosh
Macintosh does not support this function. Macintosh users need to 
change the default setting manually each time they want to print using 
other settings. 
1. Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Print.
3. Go to Paper Feed pane.
4. Open the File menu and click Print.
5. Go to Paper Feed.
6. Set appropriate tray from which you want to print.
7. Go to Paper pane.
8. Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
9. Click Print to print. 
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SETTING JOB TIMEOUT
When there is no input for a certain period of time, the machine exits the 
current menu and goes in to the default settings. You can set the amount of 
time the machine will wait.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Job Timeout appear and press OK.
5. Enter the time using left/right arrow or numeric keypad.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.
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6.media and tray
This chapter provides information on how to load originals and print media into your machine.
This chapter includes:
• Preparing originals
• Loading originals
• Selecting print media
• Changing the tray size

• Loading paper in the tray
• Printing on special media
• Setting the paper size and type
• Using the output support

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

PREPARING ORIGINALS
• Do not load paper smaller than 142 x 148 mm (5.6 x 5.8 inches) or 

larger than 216 x 356 mm (8.5 x 14 inches).
• Do not attempt to load the following types of paper, in order to prevent 

paper jam, low print quality and machine damage.
- Carbon-paper or carbon-backed paper
- Coated paper
- Onion skin or thin paper
- Wrinkled or creased paper
- Curled or rolled paper
- Torn paper

• Remove all staples and paper clips before loading.
• Make sure any glue, ink, or correction fluid on the paper is completely 

dry before loading.
• Do not load originals that include different sizes or weights of paper.
• Do not load booklets, pamphlets, transparencies, or documents with 

other unusual characteristics.

LOADING ORIGINALS
You can use the scanner glass or the automatic document feeder to load an 
original for copying, scanning, and sending a fax.

On the scanner glass
Make sure that no originals are in the document feeder. If an original is 
detected in the document feeder, the machine gives it priority over the 
original on the scanner glass. To get the best scan quality, especially for 
colored or gray-scaled images, use the scanner glass.

1. Lift and open the scanner lid.

2. Place the original face down on the scanner glass. And align it with the 
registration guide at the top left corner of the glass.

3. Close the scanner lid.
• Leaving the scanner lid open while copying may affect copy 

quality and toner consumption.
• Dust on the scanner glass may cause black spots on the 

printout. Always keep it clean. (See "Cleaning the scan unit" on 
page 88.)

• If you are copying a page from a book or magazine, lift the 
scanner lid until its hinges are caught by the stopper and then 
close the lid. If the book or magazine is thicker than 30 mm, 
start copying with the lid open.

• Be careful not to break the scanner glass. You may get hurt.
• Do not put hands while closing the scanner lid. The scanner lid 

may fall on your hands and get hurt.
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• Do not look the light from inside of the scanner while copying or 
scanning. It is harmful to eyes.

In the document feeder
Using the document feeder, you can load up to 50 sheets of paper (80 g/m2,
20 lb bond) for one job. 
1. Flex or fan the edge of the paper stack to separate the pages before 

loading originals.

2. Load the original face up into the document feeder. Make sure that the 
bottom of the original stack matches the paper size marked on the 
document input tray.

3. Adjust the document width guides to the paper size.

Dust on the document feeder glass may cause black lines on the 
printout. Always keep the glass clean. (See "Cleaning the scan 
unit" on page 88.)

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your machine. 

Guidelines to select the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality

• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications. (See "Print media specifications" 
on page 109.)

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which cannot be controled.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by the 
warranty or service agreements.
The amount of paper put into the tray may differ according to media 
type used. (See "Print media specifications" on page 109.)

Media sizes supported in each mode

• tray 1
• manual tray

• tray 1
• manual tray

• tray 1

CHANGING THE TRAY SIZE
The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

MODE SIZE SOURCE

Copy mode Letter, A4, Legal, 
Oficio, Folio, 
Executive, ISO B5, JIS 
B5, A5, A6

Print mode All sizes supported by 
the machine.

Fax mode Letter, A4, Legal
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1. With one hand press and hold the guide lock, and with the other hand, 
hold the paper length guide and support guide together. Slide the paper 
length guide and support guide to locate them in the correct paper size 
slot.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers. Insert the paper into the tray.

3. After inserting paper into the tray, adjust the support guide so that it 
lightly touches the paper stack.

4. Squeeze the paper width guides and slide them to the desired paper 
size marked at the bottom of the tray.

• Do not push the paper width guide too far causing the media to 
warp. 

• If you do not adjust the paper width guide, it may cause paper 
jams.

LOADING PAPER IN THE TRAY
Tray 1
1. Pull out the paper tray . And adjust the tray size to the media size you 

are loading. (See "Changing the tray size" on page 48.)
2. Flex or fan the edge of the paper stack to separate the pages before 

loading paper.

3.  And place paper with the side you want to print facing down.

4. Set the paper type and size for the tray 1. (See "Setting the default tray 
and paper" on page 45.)

If you experience problems with paper feeding, check whether the 
paper meets the media specification. Then try placing one sheet at 
a time in the manual tray. (See "Print media specifications" on 
page 109.)

Manual tray
The manual tray can hold special sizes and types of print material, such as 
postcards, note cards, and envelopes. It is useful for single page printing on 
letterhead or colored paper.

Tips on using the manual tray
• If you select Manual Feeder for Source from your software 

1 Support guide
2 Paper length guide
3 Guide lock
4 Paper width guide
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application, you need to press OK each time you print a page and 
load only one type, size and weight of print media at a time in the 
manual tray.

• To prevent paper jams, do not add paper while printing when there is 
still paper in the manual tray. This also applies to other types of print 
media.

• Print media should be loaded face up with the top edge going into 
the manual tray first and be placed in the center of the tray.

• Always load the specified print media only to avoid paper jams and 
print quality problems. (See "Print media specifications" on 
page 109.)

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the manual tray.

1. Load the paper in the manual tray.

• Do not force the paper beyond the surface with mark 
when loading. 

• When printing the special media, you must follow the 
loading guideline. (See "Printing on special media" on 
page 50.)

• When papers overlap when printing using manual tray, 
open tray 1 and remove overlapping papers then try 
printing again. 

• When paper does not feed well while printing, push the 
paper in manually until it starts feeding automatically. 

2. Squeeze the manual tray paper width guides and adjust them to the 
width of the paper. Do not force them too much, or the paper will 
bent resulting in a paper jam or skew.

3. To print in application, open an application and start the print menu.
4. Open Printing Preferences. (See "Opening printing preferences" on 

page 55.)
5. Press the Paper tab in Printing Preferences, and select an 

appropriate paper type.

For example, if you want to use a label, set the paper type to 
Label.

6. Select Manual Feeder in paper source, then press OK.
7. Start printing in application.

If you are printing multiple pages, load the next sheet after the first 
page prints out, and press the OK. Repeat this step for every page 
to be printed.

PRINTING ON SPECIAL MEDIA
The table below shows the available special media for each tray. 

When using special media, we recommend you feed one paper at a 
time. Check the maximum input number of media for each tray. (See 
"Print media specifications" on page 109.)

The media types are shown in the Printing Preferences. This paper type 
option allows you to set the type of paper to be loaded in the tray. This 
setting appears in the list, so that you can select it. This will let you get the 
best quality printout. If not, the desired print quality may not be achieved.
• Plain: Normal plain paper. Select this type if your machine is 

monochrome and printing on the 60 to 90 g/m2 (16 to 24 lb).
• Thick: 90 to 105 g/m2 (24 to 28 lb) thick paper.
• Thin: 60 to 70 g/m2 (16 to 19 lb) thin paper.
• Bond: 105 to 120 g/m2 (28 to 32 lb) bond. 
• Color: 75 to 90 g/m2 (20 to 24 lb) color-backgrounded paper.
• CardStock: 90 to 163 g/m2 (24 to 43 lb) cardstock. 
• Labels: 120 to 150 g/m2 (32 to 40 lb) labels. 
• Transparency: 138 to 146 g/m2 (37 to 39 lb) transparency paper. 
• Envelope: 75 to 90 g/m2 (20 to 24 lb) envelope.
• Preprinted: 75 to 90 g/m2 (20 to 24 lb) preprinted/letterhead paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lb) cotton paper.
• Recycled: 75 to 90 g/m2 (20 to 24 lb) recycled paper.
• Archive: 70 to 90 g/m2 (19 to 24 lb) If you need to keep the print-out for 

a long period time, such as archives, select this option. 

TYPES TRAY 1 MANUAL TRAY

Plain O O

Thick O O

Thin O O

Bond X O

Color X O

CardStock X O

Labels X O

Transparency X O

Envelope X O

Preprinted X O

Cotton X O

Recycled O O

Archive O O
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Envelope
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print an envelope, place it flap side down with the stamp area on the 
bottom right side.

If envelopes are printed out with wrinkles, crease or black bold lines, open 
the rear cover and pull down the pressure lever and try printing again. Keep 
the rear cover opened during printing. 

• When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed 

90 g/m2 otherwise, jam may occur.
- Construction: Prior to printing, envelopes should lie flat with less 

than 6 mm curl, and should not contain air.
- Condition: Envelopes should not be wrinkled, nicked, nor 

damaged.
- Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature for 0.1 second. To view the fusing temperature, 
check your machine’s specification. (See "General specifications" on 

page 105.) The extra flaps and strips might cause wrinkling, creasing, or 
jams, and may even damage the fuser.

• For the best print quality, position margins no closer than 15 mm from 
the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparency
To avoid damaging the machine, use only transparencies designed for use 
in laser printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies in the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle them carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separates from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 
• Recommended media: Transparency for a color laser printer by Xerox, 

such as 3R 91331 (A4), 3R 2780 (Letter).

Labels
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives: The adhesive material should be stable at your 

machine’s fusing temperature. Check your machine’s specification to 
view the fusing temperature. (See "General specifications" on 
page 105.)

- Arrangement: Only use labels with no exposed backing between 
them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm 
of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

1 Pressure lever



Media and tray_ 52

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/ Custom-sized paper
Postcards, cards and other custom-sized materials can be printed with this 
machine.

• Do not print on media smaller than 76 mm (3.00 inches) wide or 127 mm 
(5.00 inches) long.

• In the software application, set margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/ Preprinted paper

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing temperature. (See "General 
specifications" on page 105.)

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

Photo
• Make sure not to use the inkjet photo paper with this machine. It could 

cause damage to the machine. 

Glossy
Load one paper to the manual tray at a time, glossy side facing up. 

• Recommended media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommended media: Glossy paper (A4) for this machine by HP
Superior Paper 160 glossy (Product: Q6616A).

SETTING THE PAPER SIZE AND TYPE
After loading paper in the paper tray, set the paper size and type using the 
control panel. These settings will apply to copy and fax modes. For 
computer printing, select the paper size and type in the application program 
you use on your computer. (See "Opening printing preferences" on 
page 55.)

The settings made from the machine driver override the settings on 
the control panel.

Setting the paper size
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Size appear and press OK.
5. Press the left/right arrow to select the paper tray you want and press 

OK.
6. Press the left/right arrow to select the paper size you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

If you want to use special-sized paper-such as a billing paper, select 
Edit... in the Paper tab in the Printing Preferences. (See "Opening 
printing preferences" on page 55.)

Setting the paper type
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Type appear and press OK.
5. Press the left/right arrow to select the paper tray you want and press 

OK.
6. Press the left/right arrow to select the paper type you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

Setting the paper source
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Paper Setup appear and press OK.
4. Press the left/right arrow until Paper Source appear and press OK.
5. Press the left/right arrow until Copy Tray or Fax Tray appear and press 

OK.
6. Press the left/right arrow to select the paper tray you want.
7. Press OK to save the selection.

SINGLE-SIDED DOUBLE-SIDED

Tray1 Face down Face up

Manual tray Face up Face down
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8. Press Stop/Clear to return to ready mode.

USING THE OUTPUT SUPPORT
The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 
surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will 
help the printed pages to align. The printer sends output to the output tray 
by default. To use the output tray, make sure that the rear cover is closed.

Stacking papers firmly
If you use a machine in a humid area, or you are using the damp print media 
caused by a high humidity, the print-outs on the output tray may be curled 
and may not be stacked properly. In this case, you can set the machine to 
use the Paper Stacking function to let print-outs stacked firmly. But, using 
this function will make the print speed slow.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Maintenance appear and press OK.
4. Press the left/right arrow until Paper Stacking appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Press Stop/Clear to return to ready mode.
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7.printing
This chapter explains common printing tasks.
This chapter includes:
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing

The procedures in this chapter are mainly based on Windows XP.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Some models or operating system may not support the certain 
feature(s) in the following table.

Printer driver

BASIC PRINTING
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

• Your Printing Preferences window that appears in this user’s 
guide may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer Specifications . 
(See "Printer specifications" on page 106.) 

• When you select an option in Printing Preferences, you may see 
a warning mark,  , or  . An exclamation mark ( ) means 
you can select that certain option but it is not recommended, and  
( ) mark means you cannot select that option due to the 
machine’s setting or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

Macintosh basic printing. (See "Macintosh printing" on page 59.)
Linux basic printing. (See "Linux printing" on page 60.)

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print
window to change the print setting. (See "Opening printing 
preferences" on page 55. )

4. To start the print job, click OK or Print in the Print window.
If you are using Windows Internet Explorer, the AnyWeb Print too will 
save your time for screen-captured images or printing the image. Click 
Start > All programs > Samsung Printers > your machine name > 
AnyWeb Print to link the website where the tool is available for the 
download.

FEATURE WINDOWS

Machine quality option O

Booklet printing O

Poster printing O

Multiple pages per sheet O

Fit to page printing O

Reduce and enlarge printing O

Different source for first page O

Watermark O

Overlay O

Double-sided printing (manual) O
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Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:
1. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows Vista, select Control Panel > Hardware and Sound > 

Printers.
2. Double-click your machine.
3. From the Document menu, select Cancel.

You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 
You can also cancel the current job by pressing Stop on the control 
panel.

OPENING PRINTING PREFERENCES
You can preview the settings you selected on the upper right of the Printing 
Preferences.
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer.
4. Click Properties or Preferences.

Using a favorite setting
The Presets option, which is visible on each preferences tab except for 
Samsung tab, allows you to save the current preferences settings for future 
use. 
To save a Presets item:

1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box.

3. Click Save. When you save Presets, all current driver settings are 
saved.

To use a saved setting, select it from the Presets drop down list. The 
machine is now set to print according to the setting you selected.
To delete s saved setting, select it from the Presets drop down list and click 
Delete.
You can also restore the printer driver’s default settings by selecting Default
Preset from the Presets drop down list.

USING HELP
Click the question mark from the upper-right corner of the window and click 
on any option you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver update or 
registration and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 55.
• "Printing posters" on page 56.
• "Printing booklets (Manual)" on page 56.
• "Printing on both sides of paper (Manual)" on page 56.
• "Change percentage of your document" on page 57.
• "Fitting your document to a selected paper size" on page 57.
• "Using watermarks" on page 57.
• "Using overlay" on page 57.
• "Advanced Options" on page 58.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
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1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Basic tab, select Multiple Pages per Side in the Type
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source, and Type.
7. Click OK or Print until you exit the Print window

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Specification of the page layout:
• Poster 2x2: Document will be enlarged and be divided into 4 

pages.
• Poster 3x3: Document will be enlarged and be divided into 9 

pages.
• Poster 4x4: Document will be enlarged and be divided into 16 

pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 

or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window
7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

If you want to make a booklet, you need to print on Letter, Legal, A4, 

Us Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source, and Type.
The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window
5. After printing, fold and staple the pages.

Printing on both sides of paper (Manual)
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. (See "Print media specifications" 
on page 109.)

We recommend not to print on both sides of the special media, such 
as labels, envelopes  or thick paper to print on both sides of paper. It 
may cause a paper jam or damage the machine. 

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Advance tab.
3. From the Double-Sided Printing (Manual) section, select the binding 

option you want.   
• None
• Long Edge: This option is the conventional layout used in 

bookbinding.

• Short Edge: This option is the conventional layout used in 
calendars.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window
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If your machine does not have a duplex unit, you should complete the 
printing job manually. The machine prints every other page of the 
document first. After that, a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
 You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the left/right arrows to select the scaling rate. 
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window

Fitting your document to a selected paper size
This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Paper tab.
3. Select the paper size you want from the Fit to page .
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the print window

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 256 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, size, and shade from the Font
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermaks list.   
6. When you have finished editing, click OK or Print until you exit the 

Print window.
To stop printing the watermark, select None from the Watermark
drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to edit from the Current Watermarks
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to delete from the Current 
Watermarks list and click Delete.

4. Click OK or Print until you exit the Print window.

Using overlay
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than 
using preprinted letterhead, you can create an overlay containing exactly 
the same information that is currently on your letterhead. To print a letter 
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with your company’s letterhead, you do not need to load preprinted 
letterhead paper in the machine just print the letterhead overlay on your 
document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.
1. Create or open a document containing text or an image for use in a 

new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences.
(See "Opening printing preferences" on page 55.)

3. Click the Advanced tab, and select Edit from the Text drop-down 
list. Edit Overlay window appears.

4. In the Edit Overlay window, click Create.
5. In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List.
7. Click OK or Print until you exit the Print window
8. The file is not printed. Instead, it is stored on your computer hard disk 

drive.
The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a 
watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:
1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 55.)

3. Click the Advanced tab. 
4. Select the desired overlay from the Text drop-down list. 
5. If the overlay file you want does not appear in theText drop-down 

list, select Edit from the list and click Load. Select the overlay file 
you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Open
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm your wish to 
print an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 
1. In the Printing Preferences window, click the Advanced tab. 
2. Select Edit in the Overlay drop down list. 
3. Select the overlay you want to delete from the Overlay List box. 
4. Click Delete.
5. When a confirming message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

Advanced Options
Use the following Graphics options to adjust the print quality for your 
specific printing needs.

If the option is grayed out or not shown, that option is not applicable 
with the printer language you are using.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 55.)

2. Click the Graphics tab.
Refer to the online help for each option’s information provided from 
the Printing Preferences.

• Font/Text: Select Darken Text to print texts darker than on a 
normal document. Use All Text Black to prints solid black, 
regardless of the color it appears on the screen.

• Toner Save Mode : Selecting this option extends the life of your 
toner cartridge and reduces your cost per page without a significant 
reduction in print quality.
- On: Select this option to allow the printer to use less toner on 

each page.
- Off: If you do not need to save toner when printing a document, 

select this option.
3. Click OK or Print until you exit the Print window.

CHANGING THE DEFAULT PRINT SETTINGS
1. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
2. Select your machine.
3. Right-click on the machine driver icon and select  

Printing Preferences.
4. Change the settings on each tab. 
5. Click OK.

Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver. 
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SETTING YOUR MACHINE AS A DEFAULT 
MACHINE
1. Click the Windows Start menu.

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
2. Select your machine.
3. Right-click your machine and select Set as Default Printer.

PRINTING TO A FILE (PRN)
You will sometimes need to save the print data as a file. 
To create a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK. For 

example c:\Temp\file name.
If you type in only the file name, the file is automatically saved in 
My Documents.

MACINTOSH PRINTING
This section explains how to print using Macintosh. You need to set the print 
environment before printing. 
• USB connected (See "Macintosh" on page 34.)
• Network connected (See "Macintosh" on page 41.)

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open the document you want to print.
2. Open the File menu and click Page Setup.

3. Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4. Open the File menu and click Print.
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window may differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties window is similar to the following.

The setting options may differ depending on printers and Macintosh 
OS version.

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the drop-down list under Orientation to access the 
following features.

• Pages per Sheet: This option determines how many pages to be 
printed on one page. (See "Printing multiple pages on one sheet of 
paper" on page 60.)

• Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

• Border: This option allows you to print a border around each page 
on the sheet.

• Reverse Page Orientation: This option allows you to rotate paper 
180 degrees. 
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Graphics
The Graphics tab provides options for selecting Resolution. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.

• Resolution (Quality): This option allows you to select the printing 
resolution. The higher the setting, the sharper the clarity of printed 
characters and graphics. The higher setting also may increase the 
time it takes to print a document.

• Darkness: This option allows you to enhance printouts. The 
available options are Normal, Light, and Dark.

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
you load a different type of print material, select the corresponding paper 
type.

Printer Settings
Printer Settings tab provides Toner Save Mode, Reprint When 
Jammed, and Power Save options. Select Printer Settings from the 
drop-down list under Orientation to access the following features:

• Toner Save Mode : Selecting this option extends the life of your 
toner cartridge and reduces your cost per page without a significant 

reduction in print quality.
- Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of 
the printer. 

- On: Select this option to allow the printer to use less toner on 
each page.

- Off: If you do not need to save toner when printing a document, 
select this option.

• Reprint When Jammed: When this option is checked, the machine 
retains the image of a printed page until the machine signals that the 
page has successfully exited the machine. If a paper jam occurs, the 
printer will reprint the last page sent from the computer after you 
have cleared the jam. 

• Power Save: When this option is checked, the machine turns to the 
power save mode after the selected time. 

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then the machine prints the selected number of pages you 

want to print on one sheet of paper.

LINUX PRINTING
Printing from applications
There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.
1. Open an application, and select Print from the File menu.
2. Select Print directly using lpr.
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3. In the LPR GUI window, select the model name of your machine from 
the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General: This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

• Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.

• Advanced: This option allows you to set the print resolution, paper 
source, and destination.

If an option is grayed out, it means that the grayed out option is not 
supported.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
lpr utility allows you to do that. But the drivers package replaces the 
standard lpr tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print
window appears first. Just select any files you want to print and click 
Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your machine as 
a printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

• Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

• Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties
window.
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8.copying
This chapter gives you step-by-step instructions for copying documents.
This chapter includes:
• Basic copy
• Changing the settings for each copy
• Changing the default copy settings

• Using special copy features
• Deciding the form of copy output
• Setting copy timeout

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

BASIC COPY
This is the normal and usual procedure for copying your originals.

1. Press (Copy) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "On the scanner glass" on page 47 or "In the document feeder" on 
page 48.)

3. If necessary, adjust the settings for each copy such as Reduce/Enlarge,
Darkness, Original Type and more. (See "Changing the settings for 
each copy" on page 62.)

4. Enter the number of copies using the arrow or number keypad, if 
necessary.

5. Press Start on the control panel to begin copying.
To cancel the current copy job, press Stop/Clear on the control panel. 

CHANGING THE SETTINGS FOR EACH COPY
Your machine provides default settings for copying so that you can quickly 
and easily make a copy. However, if you want to change the options for 
each copy, use the copy function buttons on the control panel.

If you press Stop/Clear while setting the copy options, all of the 
options you have set for the current copy job will be canceled and 
return to their default status after the machine completes the copy in 
progress

Changing the darkness
If you have an original containing faint marking and dark images, you can 
adjust the brightness to make a copy that is easier to read.

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Darkness appear and press OK.
5. Press the left/right arrow until the contrast mode you want appears and 

press OK.
• Light: Works well with dark print.
• Lightest: Works well with darker print.
• Normal: Works well with standard typed or printed originals.
• Dark: Works well with light print.

• Darkest: Works well with lighter print or faint pencil markings.
6. Press Stop/Clear to return to ready mode.

Selecting the type of originals
The original type setting is used to improve the copy quality by selecting the 
document type for the current copy job.

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Original Type appear and press OK.
5. Press the left/right arrow until the image mode you want appears and 

press OK.
• Text: Use for originals containing mostly text.
• Text/Photo: Use for originals with mixed text and photographs.
• Photo: Use when the originals are photographs.

6. Press Stop/Clear to return to ready mode.

Reducing or enlarging copies
You can reduce or enlarge the size of a copied image from 25% to 400% 
when you copy original documents from the scanner glass, or from 25% to 
100% from the ADF.

To select from the predefined copy sizes:
1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Reduce/Enlarge appear and press 

OK.
5. Press the left/right arrow until the size setting you want appears and 

press OK.
6. Press Stop/Clear to return to ready mode.

To scale the copy by directly entering the scale rate:
1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Reduce/Enlarge appear and press 

OK.
5. Press the left/right arrow until Custom appear and press OK.
6. Press the left/right arrow or numeric keypad to enter the copy size 

you want. Pressing and holding the left/right arrow allows you to 
quickly scroll to the number you want.

7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.
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When you make a reduced copy, black lines may appear at the 
bottom of your copy.

CHANGING THE DEFAULT COPY SETTINGS
The copy options, including darkness, original type, copy size, collation and 
number of copies, can be set to those most frequently used. When you copy 
a document, the default settings are used unless they have been changed 
by using the corresponding buttons on the control panel.

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Setup appear and press OK.
4. Press the left/right arrow until Change Default appear and press OK.
5. Press the left/right arrow until the setup option you want appears and 

press OK.
6. Press the left/right arrow until the setting you want appears and press 

OK.
7. Repeat steps 5 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

While you are setting copy options, pressing Stop/Clear cancels the 
changed settings and restores the defaults.

USING SPECIAL COPY FEATURES
You can use the following copy features:

ID card copying
Your machine can print 2-sided originals on one sheet of A4-, Letter-, 
Legal-, Folio-, Executive-, B5, A5, or A6-sized paper.
The machine prints one side of the original on the upper half of the paper 
and the other side on the lower half without reducing the size of the original. 
This feature is helpful for copying a small-sized item, such as a business 
card.

• This copy feature is available only when you place originals on the 
scanner glass.

• The size of the 2-sided originals should be smaller than A5, if not, 
some of it won’t be copied. 

1. Press ID Copy on the control panel. 
2. Place Front Side and Press [Start] appears on the display.
3. Place the front side of an original facing down on the scanner glass 

where arrows indicate as shown, and close the scanner lid. 

4. Press OK on the control panel.
Your machine begins scanning the front side and shows Place Back 
Side and Press [Start].

5. Turn the original over and  place it on the scanner glass, where arrows 
indicate as shown then, close the scanner lid.

6. Press OK on the control panel to begin copying.
• If the original is larger than the printable area, some portions may 

not be printed.
• If you don’t press the OK button, only the front side will be copied.
• If you press Stop/Clear, the machine cancles the copy job and 

returns to ready mode. 

2-up or 4-up copying (N-up)
The machine reduces the size of the original images and prints 2 or 4 pages 
onto one sheet of paper.

1
2

1 2

3 4

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Layout appear and press OK.
5. Press the left/right arrow until 2-Up or 4-Up appear and press OK.
6. When Yes appears, press OK.
7. Press Start on the control panel to begin copying.

You cannot adjust the copy size using the Reduce/Enlarge for the 
N-Up feature. 

Poster copying
Your original will be divided into 9 portions. You can paste the printed pages 
together to make one poster-sized document.
This copy feature is available only when you place originals on the scanner 
glass. 

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Layout appear and press OK.
5. Press the left/right arrow until Poster Copy appear and press OK.
6. Press Stop/Clear to return to ready mode.
7. Press Start on the control panel to begin copying.

Your original is divided into 9 portions. Each portion is scanned and 
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printed one by one in the following order:

Clone copying
The machine prints multiple original images on a single page. The number 
of images is automatically determined by the original image and the paper 
size.
This copy feature is available only when you place originals on the scanner 
glass.

1. Press (Copy) on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Feature appear and press OK.
4. Press the left/right arrow until Layout appear and press OK.
5. Press the left/right arrow until Clone Copy appear and press OK.
6. When Yes appears, press OK.
7. Press Start on the control panel to begin copying.

You cannot adjust the copy size using the Reduce/Enlarge for the 
Clone Copy feature. 

DECIDING THE FORM OF COPY OUTPUT 
You can set the machine to sort the copy job. For example, if you make 2 
copies of a 3 page original, one complete 3 page document will print follwed 
by a second complete document.

1. Press (Copy) on the control panel. 
2. Place originals, face up, in the document feeder. Or you can use the 

scanner glass with a single original document face down and closed the 
scanner lid.

3. Press OK and enter the number of copies using the left/right arrow or 
numeric keypad.

4. Press Menu on the control panel.
5. Press the left/right arrow until Copy Setup appear and press OK.
6. Press the left/right arrow until Change Default appear and press OK.
7. Press the left/right arrow until Copy Collation appear and press OK.
8. Press the left/right arrow until On appear and press OK.

• On: Prints output in sets to match the sequence of originals.

• Off: Prints output sorted into stacks of individual pages.

9. Press Stop/Clear to return to ready mode.
10. Press Start to begin copying.

One complete document will print followed by the second complete 
document.

SETTING COPY TIMEOUT
You can set the time the machine waits before it restores the default copy 
settings, if you do not start copying after changing them on the control 
panel.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Timeout appear and press OK.
5. Press the left/right arrow until the time setting you want appears.

Selecting Off means that the machine does not restore the default 
settings until you press Start to begin copying, or Stop/Clear to cancel.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.
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9.scanning
Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer.
This chapter includes:
• Basic scanning method
• Scanning originals and sending to your computer (Scan to PC)
• Using Samsung Scan Manager
• Scanning with TWAIN-enabled software

• Scanning using the WIA driver
• Macintosh scanning
• Linux Scanning

The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, 
depending on your system and what you are scanning, you may not 
be able to scan at certain resolutions, especially using enhanced 
resolution.

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

BASIC SCANNING METHOD
You can scan the originals with your machine via an USB cable or the 
network.
• Samsung Scan Manager: You just walk to the machine with the 

originals and scan them from the control panel  Then, the scanned data 
will be stored in the connected computers My Documents folder. When 
you install all the softwares in the supplied CD, the Samsung Scan 
Manager is also automatically installed on your computer. This feature 
can be used via the local connection or the network connection. (See 
"Using Samsung Scan Manager" on page 66.)

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning 
an image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or 
the network connection. (See "Scanning with TWAIN-enabled software" 
on page 67.)

• SmarThru Office : This program is the accompanying software for your 
machine. You can use this program to scan images or documents. This 
feature can be used via the local connection or the network connection. 
(See "Smarthru" on page 83.)

• WIA: WIA stands for Windows Images Acquisition. To use this feature, 
your computer must be connected directly with the machine via an USB 
cable. (See "Scanning using the WIA driver" on page 67.)

SCANNING ORIGINALS AND SENDING TO 
YOUR COMPUTER (SCAN TO PC)
You can scan an image on the machine via the Samsung Scan Manager 
program that is installed in your networked computer.

For USB connected machine
This is a basic scanning method for usb connected machine.

1. Make sure that the machine is connected to your computer and powered 
on.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. Press (Scan) on the control panel. 
4. Press the left/right arrow until Scan To PC appear and press OK.
5. Press the left/right arrow until Local PC appear and press OK.

If you see Not Available message, check the port connection.

6. Press the left/right arrow until the application program you want appears 
and press OK.
Default setting is My Documents.

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan Manager > 
Properties > Set Scan Button.

7. Press the left/right arrow until the setting you want appears and press 
OK.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode.
• Scan Format: Sets the file format in which the image is to be saved.
• Scan Size: Sets the image size.

• Scan Format appears only when you selected the Scan 
destination to My Documents.

• If you want to scan from the default setting, press Start.

8. Scanning begins.
• Scanned image is saved in computer’s My Documents > My 

Pictures > Samsung folder.

• You can use Twain driver to scan quickly in Samsung Scan 
Manager program.

• You can also scan by pressing Window’s Start > Control 
Panel > Samsung Scan Manager > Quick Scan.

For network connected machine
Make sure the printer driver is installed on your computer using the software 
CD, since the printer driver includes the scan program. (See "Installing 
wired network or USB connected machine’s driver" on page 39.)
1. Make sure that your machine and the computer are connected to a 

network and Samsung Scan Manager is installed on the computer.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
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3. Press (Scan) on the control panel.
4. Press the left/right arrow until Scan To PC appear and press OK.
5. Press the left/right arrow until Network PC appear and press OK.

If you see Not Available message, check the port connection.

6. Select your registered computer ID, and enter the Password if 
necessary.

• ID is the same ID as the registered Computer ID for Samsung 
Scan Manager.

• Password is the 4 digit number registered Password for 
Samsung Scan Manager.

7. Press the left/right arrow until the application program you want appears 
and press OK.
Default setting is My Documents.

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan Manager > 
Properties > Set Scan Button.

8. Press the left/right arrow until the setting you want appears and press 
OK.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode.
• Scan Format: Sets the file format in which the image is to be saved.
• Scan Size: Sets the image size.

• Scan Format appears only when you selected the Scan 
destination to My Documents.

• If you want to scan from the default setting, press Start.

9. Scanning begins.
• Scanned image is saved in computer’s My Documents > My 

Pictures > Samsung folder.

• You can use Twain driver to scan quickly in Samsung Scan 
Manager program.

• You can also scan by pressing Window’s Start > Control
Panel > Samsung Scan Manager > Quick Scan.

USING SAMSUNG SCAN MANAGER
If you have installed the printer driver, Samsung Scan Manager program 
has installed too. Start Samsung Scan Manager program to find out about 
this program information and the installed scan driver's condition. Through 
this program, you can change scan settings and add or delete the folders 
where scanned documents are saved in your computer. 

The Samsung Scan Manager program can only be used in the 
Window and Macintosh system. If you use the Macintosh, See 
"Setting scan information in Scan Manager" on page 68.

1.  From the Start menu, click Control Panel > Samsung Scan Manager.
You can open Samsung Scan Manager by right clicking the Smart 
Panel icon in the Windows task bar and seleting Scan Manager.

2. Select the appropriate machine from the Samsung Scan Manager
window.

3. Press Properties.
4. The Set Scan Button tab allows you to change the saving destination 

and scan settings, add or delete application program, and format files.

You can change the scanning machine by using the Change Port tab. 
(Local or Network)

5. When setting is done, press OK.

Set Scan Button tab

Scan Destination
• Available Destination List: Shows the list of applications currently 

linked to scanned images in the PC’s registry. Select the program 
you want to use and click the right arrow and add to Front Panel 
Destination List.

• Front Panel Destination List: Shows the list of applications to 
open scanned image.

• Add Application: Allows you to add application you want to use to 
Available Destination List,

• Remove Application: Allows you to remove an item added by the 
user in the Available Destination List.

• File Format: Allows you to select the form of scanned data to be 
saved. You can choose among BMP, JPEG, PDF, and TIFF.

Scan Property
• Computer ID: Shows the ID of your computer. 
• Save Location: Allows you to choose the location of the default 

saving folder.
• Resolution: Allows you to choose the scan resolution. 
• Scan Color: Allows you to choose the scan color. 
• Scan Size: Allows you to choose the scan size. 
• ADF Duplex: Automatically scans both sides. If your model does 

not support this option, it will be grayed out. 
• Show Preview: Checking this box allows you to preview applied 

scan options. You can modify the options before scanning. 
• Default: Allows you to go back to default options. 
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Change Port tab

Local Scanner
Select when your machine is connected via USB or LPT port. 

Network Scanner
Select when your machine is connected via network port.
• Auto detection on the network: Automatically detects your 

machine.
• IP address: Enter in your machine’s IP address to detect your 

machine. 

SCANNING WITH TWAIN-ENABLED SOFTWARE
If you want to scan documents using other softwares, you will need to use 
TWAIN-compliant software, such as Adobe Photoshop. 
Follow the steps below to scan with TWAIN-compliant software:
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. Open an application, such as Adobe Photoshop.
4. Open the TWAIN window and set the scan options.
5. Scan and save your scanned image.

SCANNING USING THE WIA DRIVER
Your machine also supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by 
Microsoft Windows XP and works with digital cameras and scanners. Unlike 
the TWAIN driver, the WIA driver allows you to scan and easily adjust 
images without using additional software.

The WIA driver works only on Windows XP/Vista with a USB port.

Windows XP
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. From the Start menu, select Control Panel, > Scanners and Cameras.

4. Double click your scanner driver icon. The Scanner and Camera 
Wizard appears.

5. Click Next.
6. Set the option in Choose scanning preferences window and click 

Preview to see how your options affect the picture.
7. Click Next.
8. Enter a picture name, and select a file format and destination to save the 

picture.
9. Your picture has been successfully copied to your computer. Choose 

one of the options on screen. 
10. Click Next.
11. Click Finish.

Windows Vista
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. From the Start menu select Control Panel > Hardware and Sound > 
Scanners and Cameras.

4. Double click Scan a document or picture. Windows Fax and Scan
application appears.

• You can click on View scanners and cameras to view 
scanners, 

• If there is no Scan a document or picture, open the MS paint 
program and from the File click From Scanner or Camera... .

5. Click New Scan. Scan driver appears.
6. Choose your scanning preferences and click Preview to see your 

preferences affect the picture.
7. Click Scan.

If you want to cancel the scan job, press the Cancel button on the 
Scanner and Camera Wizard.

MACINTOSH SCANNING
You can scan documents using Image Capture program. Macintosh OS 
offers Image Capture program. 

Scanning with USB
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. Start Applications and click Image Capture.
If No Image Capture device connected message appears, 
disconnect the USB cable and reconnect it. If the problem 
continues,refer to the Image Capture’s help.

4. Set the scan options on this program.
5. Scan and save your scanned image.

• For more information about using Image Capture, refer to the 
Image Capture’s help.

• Use TWAIN-compliant softwares to apply more scan options.
• You can also scan using TWAIN-compliant softwares, such as 

Adobe Photoshop.
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• Scan process differ according to TWAIN-compliant softwares. 
Please refer to the user’s guide of the software.

• If scanning does not operate in Image Capture, update Mac OS to 
the latest version. Image Capture operates properly in Mac OS X 
10.3.9 or higher and Mac OS X 10.4.7 or higher.

Scanning with network
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder , or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

3. Start Applications and click Image Capture.
4. Click Devices and click Browse Devices.
5. For Mac OS X 10.4:

Select your machine in Twain devices option. Make sure that Use 
TWAIN software checkbox is checked, and click Connect.
• If a warning message appears, click Change Port.. to select port. 
• If TWAIN UI appears, from the Preference tab, click Change Port..

to select port. 

Refer to  Scan Manager for Change port.. use. (See "Setting 
scan information in Scan Manager" on page 68.)

For Mac OS X 10.5 ~ 10.6:
Make sure that Connected checkbox is checked beside your machine in 
Bonjour Devices.
If you want to scan using TWAIN, refer to the Mac OS X10.4 steps 
above.

6. Set the scan options on this program.
7. Scan and save your scanned image.

• For Mac OS X 10.3, use TWAIN-compliant softwares. 
• For more information about using Image Capture,refer to the 

Image Capture’s help.
• Use TWAIN-compliant softwares to apply more scan options. 
• You can also scan using TWAIN-compliant softwares, such as 

Adobe Photoshop.
• Scan process differ according to TWAIN-compliant softwares. 

Please refer to the user’s guide of the software.
• If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly in Mac OS X 
10.4.7 or higher.

Setting scan information in Scan Manager
To find out about Scan Manager program information, to check the 
installed scan driver's condition, to change scan settings. and to add or 
delete the folders where scanned documents to computer are saved in 
Scan Manager program, follow these instructions:
1. From the Smart Panel menu on Status bar, click Scan Manager. 
2. Select the appropriate machine from the Scan Manager .
3. Press Properties.
4. Use Set Scan Button to change the file destination or scan settings, 

to add or delete application programs, and to format files. You can 
change the scanning machine by using Change port. (Local or 
Network) 

5. When done, press OK.

LINUX SCANNING
You can scan a document using the Unified Driver Configurator window.

Scanning
1. Double-click the Unified Driver Configurator on your desktop.

2. Click the  button to switch to Scanners Configuration.
3. Select the scanner on the list.

If you use only one machine device and it is connected to the computer 
and turned on, your scanner appears on the list and is automatically 
selected.
If you have two or more scanners connected to your computer, you can 
select any scanner to work at any time. For example, while acquisition is 
in progress on the first scanner, you may select the second scanner, set 
the device options and start the image acquisition simultaneously.

4. Click Properties.
5. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "Loading originals" on page 47.)

6. From the Scanner Properties window, click Preview.
The document is scanned and the image preview appears in the 
Preview Pane.
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7. Drag the pointer to set the image area to be scanned in the Preview 
Pane.

8. Change the scan options in the Image Quality and Scan Area sections.
• Image Quality: This option allows you to select the color 

composition and the scan resolution for the image.
• Scan Area: This option allows you to select the page size. The 

Advanced button enables you to set the page size manually.
If you want to use one of the preset scan option settings, select the 
option from the Job Type drop-down list. (See "Adding Job Type 
Settings" on page 69.)
Click Default to restore the default setting for the scan options.

9. When you have finished, click Scan to start scanning.
The status bar appears on the bottom left of the window to show you the 
progress of the scan. To cancel scanning, click Cancel.

10. The scanned image appears.
If you want to edit the scanned image, use the toolbar. (See "Using the 
Image Manager" on page 69.)

11. When you are finished, click Save on the toolbar.
12. Select the file directory where you want to save the image and enter the 

file name.
13. Click Save.

Adding Job Type Settings
You can save your scan option settings for later use.

To save a new Job Type setting:
1. Change the options from the Scanner Properties window.
2. Click Save As.
3. Enter the name for your setting.
4. Click OK.

Your setting is added to the Saved Settings drop-down list.

To save a Job Type setting for the next scan job:
1. Select the setting you want to use from the Job Type drop-down list.
2. The next time you open the Scanner Properties window, the saved 

setting is automatically selected for the scan job.

To delete a Job Type setting
1. Select the setting you want to delete from the Job Type drop-down 

list.
2. Click Delete.

The setting is deleted from the list.

Using the Image Manager
The Image Manager application provides you with menu commands and 
tools to edit your scanned image.

Use the following tools to edit the image:

For further details about the Image Manager application, refer to the on 
screen help.

TOOLS NAME FUNCTION

Save Saves the image.

Undo Cancels your last action.

Redo Restores the action you canceled.

Scroll Allows you to scroll through the image.

Crop Crops the selected image area.

Zoom Out Zooms the image out.

Zoom In Zooms the image in.

Scale Allows you to scale the image size; you can 
enter the size manually, or set the rate to scale 
proportionally, vertically, or horizontally.

Rotate Allows you to rotate the image; you can select 
the number of degrees from the drop-down list.

Flip Allows you to flip the image vertically or 
horizontally. 

Effect Allows you to adjust the brightness or contrast of 
the image, or to invert the image.

Properties Shows the properties of the image.
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10.faxing
This chapter gives you information about using your machine as a fax machine.
This chapter includes:
• Preparing to fax
• Sending a fax
• Receiving a fax
• Adjusting the document settings

• Forwarding a fax to other destination
• Setting up address book
• Printing sent fax report automatically

• You cannot use this machine as a fax via the internet phone. For 
more information ask the internet service provider.

• We recommend you to use traditional analog phone services 
(PSTN: public switched telephone network) when connecting 
telephone lines to use Fax. If you use other Internet services (DSL, 
ISDN, VolP), you can improve the connection quality by using the 
Micro-filter. The Micro-filter eliminates unnecessary noise signals 
and improves connection quality or Internet quality. Since the DSL 
Micro-filter is not provided with the machine, contact your Internet 
Service provider for use on DSL Micro-filter.

1 Line port
2 Micro filter
3 DSL modem / Telephone line

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

PREPARING TO FAX
Before you send or receive a fax, you need to connect the supplied line cord 
to the wall jack. Refer to the Quick Install Guide how to make a connection. 
The method of making a telephone connection is varies from one country to 
another.

SENDING A FAX
This part explains how to send a fax and the special methods of 
transmission.

When you place the originals, you can use either the document feeder 
or the scanner glass. (See "Loading originals" on page 47.) If the 
originals are placed on both the document feeder and the scanner 
glass, the machine will read the originals on the document feeder first, 
which has higher priority in scanning.

Setting the fax header
In some countries, you are required by law to indicate your fax number on 
any fax you send. 
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Machine Setup appear and press OK.
4. Press the left/right arrow until Machine ID appear and press OK.
5. Enter your name or the company name using the number keypad. You 

can enter alphanumeric characters using the number keypad, and 
include special symbols by pressing the 1 button. For details on how to 
enter alphanumeric characters, see "Entering characters using the 
number keypad" on page 44.

6. Press OK to save the ID.
7. Press the left/right arrow until Machine Fax No. appear and press OK.
8. Enter your fax number using the number keypad and press OK.
9. Press Stop/Clear to return to ready mode.

Sending a fax 
1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
(See "On the scanner glass" on page 47 or "In the document feeder" on 
page 48.)

3. Adjust the resolution and the darkness to suit your fax needs. (See 
"Adjusting the document settings" on page 73.)

4. Enter the receiving fax machine’s number.
You can use speed dial numbers, or group dial numbers. For details 
about storing and searching for a number, see "Setting up address 
book" on page 75.

5. Press Start on the control panel. The machine starts to scan and send a 
fax to destinations.

• If you want to send fax directly from your computer, use SmarThru 
Office. (See "Smarthru" on page 83.)

• When you want to cancel a fax job, press Stop/Clear before the 
machine start transmission.

• If you used the scanner glass, the machine shows the message 
asking to place another page.

• While the machine is sending a fax, you can not send an email at 
the same time.

Sending a fax manually
This method is sending a fax using On Hook Dial on the control panel.



Faxing_ 71

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs. (See 

"Adjusting the document settings" on page 73.)
4. Press On Hook Dial on the control panel or lift the handset.
5. Enter a fax number using the number keypad on the control panel.
6. Press Start when you hear a high-pitched fax signal from the remote fax 

machine.
When you want to cancel a fax job, press Stop/Clear at any time while 
sending.

Confirming a transmission
When the last page of your original has been sent successfully, the machine 
beeps and returns to ready mode.
When something goes wrong while sending your fax, an error message 
appears on the display. For a list of error messages and their meanings, see 
"Understanding display messages" on page 94. If you receive an error 
message, press Stop/Clear to clear the message and try to send the fax 
again.
You can set your machine to print a confirmation report automatically each 
time sending a fax is completed. For further details, see "Printing sent fax 
report automatically" on page 76.

Automatic redialing
When the number you have dialed is busy or there is no answer when you 
send a fax, the machine automatically redials the number every three 
minutes, up to seven times according to the factory default settings..
When the display shows Retry Redial?, press OK to redial the number 
without waiting. To cancel the automatic redialing, press Stop/Clear.
To change the time interval between redials and the number of redial 
attempts. (see "Changing the fax setup options" on page 77.)

Redialing the last number
To redial the number you called last:
1. Press Redial/Pause on the control panel.
2. When an original is loaded in the document feeder, the machine 

automatically begins to send.
If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK. When you have finished, 
select No at the Another Page? prompt.

Sending a fax to multiple destinations
You can use the Multiple Send feature, which allows you to send a fax to 
multiple locations. Originals are automatically stored in memory and sent to 
a remote station. After transmission, the originals are automatically erased 
from memory. You cannot send a color fax using this feature.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs. (See 

"Adjusting the document settings" on page 73.)
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appear and press OK.
6. Press the left/right arrow until Multi Send appear and press OK.
7. Enter the number of the first receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 

Address book button. For details, see "Setting up address book" on 
page 75.

8. Enter the second fax number and press OK.
The display asks you to enter another fax number to send the document.

9. To enter more fax numbers, press OK when Yes appears and repeat 
steps 7 and 8. You can add up to 10 destinations.

10. Press OK to start storing the scanned original data into memory.
Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

11. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.

12. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine begins sending the fax to the numbers you entered in the 
order in which you entered them.

Delaying a fax transmission
You can set your machine to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs. (See 

"Adjusting the document settings" on page 73.)
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appear and press OK.
6. Press the left/right arrow until Delay Send appear and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up address book" on 
page 75.

8. The display asks you to enter another fax number to send the document.
9. To enter more fax numbers, press OK when Yes appears and repeat 

steps 7. You can add up to 10 destinations.
Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

10. When you have finished entering fax numbers, press the left/right arrow 
to select No at the Another No.? prompt and press OK.

11. Enter the job name you want and press OK.
For details on how to enter alphanumeric characters, see "Entering 
characters using the number keypad" on page 44.
If you do not want to assign a name, skip this step.

12. Enter the time using the number keypad and press OK.
If you set a time earier than the current time, the fax will be sent at 
that time on the following day.

The original is scanned into memory before transmission.
13. If an original is placed on the scanner glass, select Yes to add another 

pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine returns to ready mode. The display reminds you that you 
are in ready mode and that a delayed fax is set.
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Adding documents to a reserved delay fax job
You can add additional documents to the delayed fax job which is saved 
in memory.
1. Load the originals to be added and adjust document settings.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Add pages appear and press OK.
5. Press the left/right arrow until the fax job you want appears and 

press OK.
When you have finished, select No at the Another Page? prompt. 
The machine scans the original into memory.

6. Press Stop/Clear to return to ready mode.

Canceling a reserved delay fax job
You can add additional documents to the delayed fax job which is saved 
in memory.
1. Press Menu on the control panel.
2. Press the left/right arrow until Fax Feature appear and press OK.
3. Press the left/right arrow until Cancel Job appear and press OK.
4. Press the left/right arrow until the fax job you want appears and 

press OK.
5. Press OK when Yes appears.

The selected fax is deleted from memory.
6. Press Stop/Clear to return to ready mode.

Sending a priority fax
This function is used when a high priority fax need to be sent ahead of 
reserved operations. The original is scanned into memory and immediately 
transmitted when the current operation is finished. In addition, priority 
transmission will interrupt a sending to multiple destinations between 
stations (example, when the transmission to station A ends, before 
transmission to station B begins) or between redial attempts.

1. Press (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.
3. Adjust the resolution and the darkness to suit your fax needs. (See 

"Adjusting the document settings" on page 73.)
4. Press Menu on the control panel.
5. Press the left/right arrow until Fax Feature appear and press OK.
6. Press the left/right arrow until Priority Send appear and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up address book" on 
page 75.

8. Enter the job name you want and press OK.
The original is scanned into memory before transmission.

9. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No at the Another Page? prompt.
The machine starts to scan and send a fax to destinations.

RECEIVING A FAX
This part explains how to receive a fax, and the special receiving methods 
available.

Changing the receive modes
Your machine is preset to Fax mode at the factory. When you receive a fax, 
the machine answers the call on a specified number of rings and 
automatically receives the fax. But if you want to change the Fax mode to 
another mode, follow the steps below:

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appear and press OK.
4. Press the left/right arrow until Receiving appear and press OK.
5. Press the left/right arrow until Receive Mode appear and press OK.
6. Press the left/right arrow until the fax reception mode you want appears.

• Fax: Answers an incoming fax call and immediately goes into the 
fax reception mode.

• Tel: Receives a fax by pressing On Hook Dial and then Start. If 
your machine is SCX-5635HN, you can receive a fax by picking up 
the handset.

• Ans/Fax: Is for when an answering machine attached to your 
machine. Your machine answers an incoming call, and the caller can 
leave a message on the answering machine. If the fax machine 
senses a fax tone on the line, the machine automatically switches to 
Fax mode to receive the fax.

• DRPD: you can receive a call using the Distinctive Ring Pattern 
Detection (DRPD) feature. Distinctive Ring is a telephone company 
service which enables an user to use a single telephone line to 
answer several different telephone numbers. For further details, see 
"Receiving faxes using DRPD mode" on page 73.

7. Press OK to save your selection.
8. Press Stop/Clear to return to ready mode.

• To use the Ans/Fax mode, attach an answering machine to the 
EXT socket on the back of your machine. 

• If you do not want other people to view your received 
documents, you can use secure receiving mode. In this mode, 
all of the received faxes are stored in memory. For further 
details, see "Receiving in secure receiving mode" on page 73.

Receiving manually in Tel mode
You can receive a fax call by pressing On Hook Dial and then pressing 
Start when you hear a fax tone from the remote machine. The machine 
begins receiving a fax. If your machine has a handset, you can answer calls 
using the handset.
To change the number of rings, see "Changing the fax setup options" on 
page 77.

Receiving automatically in Answering Machine/Fax 
mode
To use this mode, you must attache an answering machine to the EXT 
socket on the back of your machine. (See "Rear view" on page 27.)
If the caller leaves a message, the answering machine stores the message 
as it would normally. If your machine detects a fax tone on the line, it 
automatically starts to receive the fax.

• If you have set your machine to this mode and your answering 
machine is switched off, or no answering machine is connected to 
EXT socket, your machine automatically goes into Fax mode after 
a predefined number of rings.

• If your answering machine has a user-selectable ring counter, set 
the machine to answer incoming calls within 1 ring.

• If you are in Tel mode when the answering machine is connected 
to your machine, you must switch off the answering machine. 
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otherwise, the outgoing message from the answering machine will 
interrupt your phone conversation.

Receiving faxes manually using an extension 
telephone
This feature works best when you are using an extension telephone 
connected to the EXT socket on the back of your machine. You can receive 
a fax from someone you are talking to on the extension telephone, without 
going to the fax machine.
When you receive a call on the extension phone and hear fax tones, press 
the keys *9* on the extension phone. The machine receives the fax.
Press the buttons slowly in sequence. If you still hear the fax tone from the 
remote machine, try pressing *9* once again.
*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
wish. For details about changing the code, see "Changing the fax setup 
options" on page 77

Receiving faxes using DRPD mode
Distinctive Ring is a telephone company service which enables an user to 
use a single telephone line to answer several different telephone numbers. 
The particular number someone uses to call you is identified by different 
ringing patterns, which consist of various combinations of long and short 
ringing sounds. This feature is often used by answering services who 
answer telephones for many different clients and need to know which 
number someone is calling in on to properly answer the phone.
Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax 
machine can learn the ring pattern you designate to be answered by the fax 
machine. Unless you change it, this ringing pattern will continue to be 
recognized and answered as a fax call, and all other ringing patterns will be 
forwarded to the extension telephone or answering machine plugged into 
the EXT socket. You can easily suspend or change DRPD at any time.
Before using the DRPD option, Distinctive Ring service must be installed on 
your telephone line by the telephone company. To set up DRPD, you will 
need another telephone line at your location, or someone available to dial 
your fax number from outside.
To set up the DRPD mode:

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appear and press OK.
4. Press the left/right arrow until Receiving appear and press OK.
5. Press the left/right arrow until Receive Mode appear and press OK.
6. Press the left/right arrow until DRPD appear and press OK.

Waiting Ring appears on the display.
7. Call your fax number from another telephone. It is not necessary to 

place the call from a fax machine.
8. When your machine begins to ring, do not answer the call. The machine 

requires several rings to learn the pattern..
When the machine completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.
Press OK when DRPD appears and start over from step 6.

• DRPD must be set up again if you re-assign your fax number, 
or connect the machine to another telephone line. 

• After DRPD has been set up, call your fax number again to 
verify that the machine answers with a fax tone. Then have a 
call placed to a different number assigned to that same line to 
be sure the call is forwarded to the extension telephone or 
answering machine plugged into the EXT socket.

Receiving in secure receiving mode
You may need to prevent your received faxes from being accessed by 
unauthorized people. You can turn on secure receiving mode to restrict 
printing of received faxes when the machine is unattended. In secure 
receiving mode, all incoming faxes go into memory. When the mode is 
deactivated, any stored faxes are printed.

Activating secure receiving mode
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Secure Receive appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Enter a four-digit password you want to use and press OK.

You can activate secure receiving mode without setting a 
password, but cannot protect your faxes.

7. Re-enter the password to confirm it and press OK.
8. Press Stop/Clear to return to ready mode.
When a fax is received in secure receiving mode, your machine stores it in 
memory and shows Secure Receive to let you know that there is a fax 
received.

Printing received faxes
1. Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2. Press the left/right arrow until Print appear and press OK.
3. Enter the four-digit password and press OK.

The machine prints all of the faxes stored in memory.

Deactivating secure receiving mode
1. Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2. Press the left/right arrow until Off appear and press OK.
3. Enter the four-digit password and press OK.

The mode is deactivated and the machine prints all faxes stored in 
memory.

4. Press Stop/Clear to return to ready mode.

Receiving faxes in memory
Since your machine is a multi-tasking device, it can receive faxes while you 
are making copies or printing. If you receive a fax while you are copying or 
printing, your machine stores incoming faxes in its memory. Then, as soon 
as you finish copying or printing, the machine automatically prints the fax. 

ADJUSTING THE DOCUMENT SETTINGS
Before starting a fax, change the following settings according to your 
original’s status to get the best quality.

Resolution
The default document settings procedure good results when using typical 
text-based originals. However, if you send originals that are of poor quality, 
or contain photographs, you can adjust the resolution to produce a higher 
quality fax. 

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
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3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Resolution appear and press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press Stop/Clear to return to ready mode.
Recommended resolution settings for different original document types are 
described in the table below:

• For memory transmission, Super Fine
mode is not available. The resolution setting 
is automatically changed to Fine

• When your machine is set to Super Fine
resolution and the fax machine with which 
you are communicating does not support 
Super Fine resolution, the machine 
transmits using the highest resolution mode 
supported by the other fax machine.

The resolution setting is applied to the current fax job. To change the 
default setting, see "Change Default" on page 78.

Darkness
You can select the degree of darkness of the original document. 

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Darkness appear and press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press Stop/Clear to return to ready mode.

The darkness setting is applied to the current fax job. To change the 
default setting, see "Change Default" on page 78.

FORWARDING A FAX TO OTHER DESTINATION
You can set the machine to forward the received or sent fax to other 
destination by a fax, an email or a server. If you are out of office but have to 
receive the fax, this feature may be useful.

When you forward a fax by an email, you firstly set the mail server and 
IP address in SyncThru™ Web Service. (See "Using SyncThru™ Web 
Service" on page 82.)

Forwarding a sent fax to other destination by a fax
You can set the machine to forward every fax you sent to other destination 
by faxing.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Fax appear and press OK.
6. Press the left/right arrow until Send Forward appear and press OK.
7. Press the left/right arrow until On appear and press OK.
8. Enter the number of the fax machine to which faxes are to be sent and 

press OK.
9. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.

Forwarding a received fax to other destination by a 
fax
With this feature, you can forward every fax you received to other 
destination by faxing. When the machine receives a fax, a fax is stored in 
the memory then, the machine sends it to the destination you have set.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Fax appear and press OK.
6. Press the left/right arrow until Rcv. Forward appear and press OK.
7. Press the left/right arrow until Forward appear and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print.

8. Enter the number of the fax machine to which faxes are to be sent and 
press OK.

9. Enter the starting time using left/right arrow or numeric keypad and 
press OK.

10. Enter the ending time using left/right arrow or numeric keypad and press 
OK.

11. Press Stop/Clear to return to ready mode.
Subsequent received faxes will be forwarded to the specified fax 
machine.

Forwarding a sent fax to other destination by an 
email
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Email appear and press OK.
6. Press the left/right arrow until Send Forward appear and press OK.
7. Press the left/right arrow until On appear and press OK.
8. Enter your email address and press OK.
9. Enter the email address to which faxes are to be sent and press OK.
10. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified email address.

MODE RECOMMENDED FOR:

Standard Originals with normal sized characters.

Fine Originals containing small characters or thin lines or 
originals printed using a dot-matrix printer.

Super Fine Originals containing extremely fine detail. Super Fine
mode is enabled only if the machine with which you 
are communicating also supports the Super Fine 
resolution.

Photo Fax Originals containing shades of gray or photographs.

Color Fax Originals with colors. Sending a color fax is enabled 
only if the machine with which you are 
communicating supports color fax reception and you 
send the fax manually. In this mode, memory 
transmission is not available.
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Forwarding a received fax to other destination by an 
email
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Email appear and press OK.
6. Press the left/right arrow until Rcv. Forward appear and press OK.
7. Press the left/right arrow until Forward appear and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print.

8. Enter your email address and press OK.
9. Enter the email address to which faxes are to be sent and press OK.
10. Press Stop/Clear to return to ready mode.

Subsequent received faxes will be forwarded to the specified email 
address.

Forwarding a sent fax to other destination by a 
server
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Server appear and press OK.
6. Press the left/right arrow until Send Forward appear and press OK.
7. Press the left/right arrow until On appear and press OK.
8. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified server.

Forwarding a received fax to other destination by 
server
1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Feature appear and press OK.
4. Press the left/right arrow until Forward appear and press OK.
5. Press the left/right arrow until Server appear and press OK.
6. Press the left/right arrow until Receive Forward appear and press OK.
7. Press the left/right arrow until Forward appear and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print.

8. Press Stop/Clear to return to ready mode.
Subsequent received faxes will be forwarded to the specified server.

SETTING UP ADDRESS BOOK
You can set up Address Book with the fax numbers you use most 
frequently. Your machine provides you with the following features for setting 
up Address Book:

Before beginning to store fax numbers, make sure that your machine 
is in Fax mode.

Speed dial numbers
You can store up to 200 frequently-used fax numbers in speed dial 
numbers.

Registering a speed dial number
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until New & Edit appear and press OK.
4. Press the left/right arrow until Speed Dial appear and press OK.
5. Enter a speed dial number between 0 and 199 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it. To start over with 
another speed dial number, press Back.

6. Enter the name you want and press OK.
For details on how to enter alphanumeric characters, see ""Entering 
characters using the number keypad" on page 44.

7. Enter the fax number you want and press OK.
8. Press Stop/Clear to return to ready mode.

Editing speed dial numbers
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until New & Edit appear and press OK.
4. Press the left/right arrow until Speed Dial appear and press OK.
5. Enter the speed dial number you want to edit and press OK.
6. Change the name and press OK.
7. Change the fax number and press OK.
8. Change the name and press OK.
9. Press Stop/Clear to return to ready mode.

Using speed dial numbers
When you are prompted to enter a destination number while sending a 
fax, enter the speed dial number at which you stored the number you 
want.
• For a one-digit (0-9) speed dial number, press and hold the 

corresponding digit button on the number keypad.
• For a two- or three-digit speed dial number, press the first digit 

button(s) and then hold down the last digit button.
You can also search through memory for an entry by pressing Address 
Book. (See "Searching Address Book for an entry" on page 76.)

Group dial numbers
If you frequently send the same document to several destinations, you can 
group these destinations and set them under a group dial number. You can 
then use a group dial number to send a document to all of the destinations 
within the group. You can set up to 100 (0 through 99) group dial numbers 
using the destination’s existing speed dial numbers.

Registering a group dial number
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until New & Edit appear and press OK.
4. Press the left/right arrow until Group Dial appear and press OK.
5. Enter a group dial number between 0 and 99 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it.
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6. Enter the name you want and press OK.
For details on how to enter alphanumeric characters, see ""Entering 
characters using the number keypad" on page 44.

7. Enter the first few letters of the speed dial’s name you want.
8. Press the left/right arrow until the name and number you want 

appears and press OK.
9. Press OK when Yes appears at the Another No.? prompt.

Repeat step 7 to include other speed dial numbers into the group.
10. When you have finished, press the left/right arrow to select No at the 

Another No.? prompt and press OK.
11. Press Stop/Clear to return to ready mode.

Editing a group dial number
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until New & Edit appear and press OK.
4. Press the left/right arrow until Group Dial appear and press OK.
5. Enter the group dial number you want to edit and press OK.
6. Enter the name you want to edit and press OK.
7. Enter the first few letters of the speed dial’s name you want to add or 

delete.
8. Press the left/right arrow until the name and number you want 

appears and press OK.
If you entered a new speed dial number, Add? appears.
If you enter a speed dial number stored in the group, Delete?
appears.

9. Press OK to add or delete the number.
10. Press OK when Yes appears to add or delete more numbers and 

repeat steps 7 and 8.
11. When you have finished, press the left/right arrow to select No at the 

Another Number? and press OK.
12. Press Stop/Clear to return to ready mode.

Using group dial numbers
To use a group dial entry, you need to search for and select it from 
memory.
When you are prompted to enter a fax number while sending a fax, 
press Address Book. See below.

Searching Address Book for an entry
There are two ways to search for a number in memory. You can either scan 
from A to Z sequentially, or you can search by entering the first letters of the 
name associated with the number.

Searching sequentially through the memory
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until Search & Dial appear and press OK.
4. Press the left/right arrow until Group Dial appear and press OK.
5. Press the left/right arrow until All appear and press OK.
6. Press the left/right arrow until the name and number you want 

appears. You can search upwards or downwards through the entire 
memory in alphabetical order.

Searching sequentially through the memory
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until Search & Dial appear and press OK.
4. Press the left/right arrow until Group Dial appear and press OK.
5. Press the left/right arrow until ID appear and press OK.
6. Enter the first few letters of the name you want.
7. Press the left/right arrow until the group dial’s name and number you 

want appears.

Deleting a Address Book for entry
1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until Delete appear and press OK.
4. Press the left/right arrow until the deleting option you want appears 

and press OK.
5. Press the left/right arrow until the searching method you want 

appears and press OK.
Select Search All to search for an entry by scanning through all 
entries in Address Book.
Select Search ID to search for an entry by the first few letters of the 
name.

6. Press the left/right arrow until the name you want appears and press 
OK.
Or, enter the first letters. Press the left/right arrow until the name you 
want appears and press OK.

7. Press OK when Yes appears to confirm the deletion.
8. Press Stop/Clear to return to ready mode.

Printing Address Book
You can check your Address Book settings by printing a list.

1. Press (Fax) on the control panel.
2. Press Address Book on the control panel.
3. Press the left/right arrow until Print appear and press OK.

The machine begins printing.

PRINTING SENT FAX REPORT 
AUTOMATICALLY
You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.

1. Press (Fax) on the control panel.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appear and press OK.
4. Press the left/right arrow until Auto Report appear and press OK.
5. Press the left/right arrow until On appear and press OK.
6. Press Stop/Clear to return to ready mode.
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11.machine status and advanced feature
This chapter explains how to browse the current status of your machine, and the method of setting for the advanced 
machine setup. Read this chapter carefully in order to use your machine's diverse features.
This chapter includes:
• Fax setup
• Copy setup
• Printing a report

• Clearing memory
• Network
• Menu overview

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

FAX SETUP
Changing the fax setup options
Your machine provides you with various user-selectable options for setting 
up the fax system. You can change the default settings for your preferences 
and needs.
To change the fax setup options:
1. Press Fax.
2. Press Menu on the control panel.
3. Press the left/right arrow until Fax Setup appear and press OK.
4. Press the left/right arrow until the fax setup item you want appears and 

press OK.
5. Press the left/right arrow until the option you want appears and press 

OK.
6. Press the left/right arrow until the desired status appears or enter the 

value for the option you have selected, and press OK.
7. If necessary, repeat steps 4 through 6.
8. Press Stop/Clear to return to ready mode.

Sending

Receiving

OPTION DESCRIPTION

Redial Times You can specify the number of redial attempts. If 
you enter 0, the machine will not redial.

Redial Term Your machine can automatically redial a remote 
fax machine if it was busy. You can set an 
interval between attempts.

Prefix Dial You can set a prefix of up to five digits. This 
number dials before any automatic dial number 
is started. It is useful for accessing a PABX 
exchange.

ECM Mode This mode helps with poor line quality and 
makes sure any faxes you send are sent 
smoothly to any other ECM-equipped fax 
machine. Sending a fax using ECM may take 
more time.

Send Report You can set your machine to print a confirmation 
report showing whether a transmission was 
successful, how many pages were sent, and 
more. The available options are On, Off, and 
On-Error, which prints only when a transmission 
is not successful.

Image TCR This function allows users to know what fax 
messages have been sent by showing sent 
messages in the transmission report. 
The first page of the message is turned into an 
image file than is printed on the transmission 
report so the users can see what messages 
have been sent.
However, you can not use this function when 
sending fax without saving the data in the 
memory.

Dial Mode This setting may not be available depending on 
your country. If you cannot reach this option, 
your machine does not support this feature.
You can set the dial mode for your machine to 
either tone dialling or pulse dialling. If you have a 
public telephone system or a private branch 
exchnage(PBX) system, you may need to select 
Pulse. Contact your local telephone company if 
you are not sure which dial mode to use.
If you select Pulse, some phone system 
features might not be available. It can also take 
longer to dial a fax or phone number.

OPTION DESCRIPTION

Receive Mode You can select the default fax receiving mode. 
For details on receiving faxes in each mode, see 
"Changing the receive modes" on page 72.

Ring to Answer You can specify the number of times the 
machine rings before answering an incoming 
call.

Stamp RCV Name This option allows the machine to automatically 
print the page number, and the date and time of 
reception at the bottom of each page of a 
received fax.

OPTION DESCRIPTION
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Change Default

• Standard: Originals with normal sized 
characters.

• Fine: Originals containing small characters 
or thin lines or originals printed using a 
dot-matrix printer.

• Super Fine: Originals containing extremely 
fine detail. Super Fine mode is enabled only 
if the machine with which you are 
communicating also supports the Super 
Fine resolution.

• For memory transmission, Super 
Fine mode is not available. The 
resolution setting is automatically 
changed to Fine.

• When your machine is set to Super
Fine resolution and the fax 
machine with which you are 
communicating does not support 
Super Fine resolution, the machine 
transmits using the highest 
resolution mode supported by the 
other fax machine.

• Photo Fax: Originals containing shades of 
gray or photographs.

• Color Fax: Originals with colors. Sending a 
color fax is enabled only if the machine with 
which you are communicating supports color 
fax reception and you send the fax manually. 
In this mode, memory transmission is not 
available.

Auto Report
You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.
For further details, see "Printing sent fax report automatically" on page 76.

COPY SETUP
Changing the copy setup options
For copy output, you can set up several options in advance.
1. Press Copy on the control panel. 
2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Setup appear and press OK.
4. Press the left/right arrow until the copy setup item you want appears and 

press OK.
5. Press the left/right arrow until the setup option you want appears and 

press OK.
6. Press the left/right arrow until the setting you want appears and press 

OK.

RCV Start Code This code allows you to initiate fax reception 
from an extension phone plugged into the EXT 
socket on the back of the machine. If you pick up 
the extension phone and hear fax tones, enter 
the code. It is preset to *9* at the factory.

Auto Reduction When receiving a fax containing pages as long 
as or longer than the paper loaded in the paper 
tray, the machine can reduce the size of the 
original to fit the size of the paper loaded in the 
machine. 
Turn on this feature if you want to automatically 
reduce an incoming page.
With this feature set to Off, the machine cannot 
reduce the original to fit onto one page. The 
original will be divided and printed in actual size 
on two or more pages.

Discard Size When receiving a fax containing pages as long 
as or longer than the paper in your machine, you 
can set the machine to discard a specific length 
from the end of the received fax. The machine 
will print the received fax on one or more sheets 
of paper, minus the data that would have been 
on the specified discard segment. 
When the received fax contains pages larger 
than the paper in your machine, and Auto 
Reduction has been turned on, the machine will 
reduce the fax to fit on the existing paper, and 
nothing will be discarded.

Junk Fax Setup This setting may not be available depending on 
your country. Using this feature, the system will 
not accept faxes sent from remote stations 
whose numbers are stored in the memory as 
junk fax numbers. This feature is useful for 
blocking any unwanted faxes.
When you turn on this feature, you can access 
the following options to set junk fax numbers.
• Add: Allows you to set up to 10 fax numbers.
• Delete: Allows you to delete the desired junk 

fax number. If you select Delete All, Allows 
you to delete all junk fax numbers.

DRPD Mode This mode enables a user to use a single 
telephone line to answer several different 
telephone numbers. In this menu, you can set 
the machine to recognize which ring patterns to 
answer. For details about this feature, see 
"Receiving faxes using DRPD mode" on 
page 73.

OPTION DESCRIPTION

OPTION DESCRIPTION

Resolution Changing the resolution setting affects the 
appearance of the received document.

Darkness You can select the default contrast mode to fax 
your originals lighter or darker.
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7. Repeat steps 4 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

Change Default

PRINTING A REPORT
You can print a report on the machine's configuration or font list, etc.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Report appear and press OK.
4. Press the left/right arrow until the report or list you want to print appears 

and press OK.
To print all reports and lists, select All Report.

5. Press OK when Yes appears to confirm printing.
The selected information prints out.

You can also print the machine's status information and browse status 
with SyncThru™ Web Service. Open the Web browser on your 
networked computer and type the IP address of your machine. When 
SyncThru™ Web Service opens, click Information > Print 
information.

CLEARING MEMORY
You can selectively clear information stored in your machine’s memory.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Clear Setting appear and press OK.
4. Press the left/right arrow until the item you want to clear appears and 

press OK.
5. Press OK when Yes appears to confirm clearing.
6. Repeat steps 4 through 5 to clear another item.
7. Press Stop/Clear to return to ready mode.

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

OPTION DESCRIPTION

Copies You can enter the number of copies using the 
number keypad.

Copy Collation You can set the machine to sort the copy job. 
For further details, see "Deciding the form of 
copy output" on page 64.

Reduce/Enlarge Reduces or enlarges the size of a copied image.

Darkness Adjusts the brightness level to make a copy that 
is easier to read, when the original contains faint 
markings and dark images.

Original Type Improves the copy quality by selecting the 
document type for the current copy job.

OPTION DESCRIPTION

Configuration This list shows the status of the user-selectable 
options. You may print this list to confirm your 
changes after changing settings.

Phone Book This list shows all of the fax numbers and email 
addresses currently stored in the machine’s 
memory.

Send Report This report shows the fax number, the number of 
pages, the elapsed time of the job, the 
communication mode, and the communication 
results for a particular fax job.
You can set up your machine to automatically 
print a transmission confirmation report after 
each fax job. (See "Sending" on page 77.)

Sent Report This report shows information on the faxes and 
emails you have recently sent.
You can set the machine to automatically print 
this report every 50 communications. (See 
"Sending" on page 77.)

Fax RCV Report This report shows information on the faxes you 
have recently received. 

Schedule Jobs This list shows the documents currently stored 
for delayed faxes along with the starting time 
and type of each operation. 

JunkFax Report This list shows the fax numbers specified as junk 
fax numbers. To add or delete numbers to or 
from this list, access the Junk Fax Setup menu. 
(See "Receiving" on page 77.)

Network Info. This list shows information on your machine’s 
network connection and configuration.

OPTION DESCRIPTION

All settings Clears all of the data stored in memory and 
resets all of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory 
default.

Copy Setup Restores all of the copy options to the factory 
default.

Scan Setup Restores all of the scan options to the factory 
default.

System Setup Restores all of the system options to the factory 
default.

Network Setup Restores all of the network options to the factory 
default.

Phone Book Clears all of the fax numbers and email address 
entries stored in memory.

Sent Report Clears all records of sent faxes and emails. 

RCV Report Clears all records of received faxes.

OPTION DESCRIPTION
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NETWORK
You may set up the network with the machine's display screen. Before doing 
that, you must have the relevant information concerning the type of network 
protocols and computer system you use. If you are not sure which setting to 
use, contact your network administrator to configure this machine to the 
network.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until the setup option you want appears and 

press OK.
4. Press the left/right arrow until the setting you want appears and press 

OK.
5. Repeat steps 3 through 4, as needed.
6. Press Stop/Clear to return to ready mode.

There are lots of parameters to be set; 
therefore, if you are not sure, leave as is, 
or consult the network administrator.

MENU OVERVIEW
The control panel provides access to various menus to set up the machine 
or use the machine’s functions. These menus can be accessed by pressing 
Menu.

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine. 

OPTION DESCRIPTION

TCP/IP (IPv4) Select appropriate protocol and configure 
parameters to use the network environment.

TCP/IP (IPv6) Selects this option to use the network 
environment through IPv6. (See "IPv6 
Configuration" on page 42.)

Ethernet Speed Configure the network transmission speed.

Clear Setting Reverts the network settings to the default 
values.

Network Info This list shows information on your machine’s 
network connection and configuration.

ITEMS OPTION

Fax Feature Darkness
Resolution
Multi Send
Delay Send
Priority Send
Forward
Secure Receive
Add Page
Cancel Job

Fax Setup Sending
Redial Times
Redial Term
Prefix Dial
ECM Mode
Send Report
Image TCR
Dial Mode

Receiving
Receive Mode
Ring to Answer
Stamp Rcv Name
Rcv Start Code
Auto Reduction
Discard Size
Junk Fax Setup
DRPD Mode

Change Default
Resolution
Darkness

Auto Report

Copy Feature Reduce/Enlarge
Darkness
Original Type
Layout

Copy Setup Change Default
Copies
Copy Collation
Reduce/Enlarge
Darkness
Original Type
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System Setup Machine Setup
Machine ID
Machine Fax No.
Date & Time
Clock Mode
Language
Default Mode
Power Save
Timeout
Job Timeout
Altitude Adj.
Toner Save

Paper Setup
Paper Size
Paper Type
Paper Source
Wide A4

Sound/Volume
Key Sound
Alarm Sound
Speaker
Ringer

Reports
All Report
Configuration
Phone Book
Send Report
Sent Report
Rcv Report
Schedule Jobs
JunkFax Report
Network Info.

Maintenance
CLR Empty Msg
Ignore Toner
Supplies Life
Toner Low Alert
Serial Number
Paper Stacking

Clear Setting
All Settings
Fax Setup
Copy Setup
Scan Setup
System Setup
Network Setup
Phone Book
Sent Report
Rcv Report

ITEMS OPTION

Network TCP/IP (IPv4)
IPv4 Activate
View Host Name
Set IP Address

Manual
DHCP
BOOTP

Show IP Address
TCP/IP (IPv6)

IPv6 Activate
DHCP v6 Config

Router
DHCP Address
DHCP Off

Ethernet Speed
Auto
10M Half
10M Full
100M Half
100M Full

Clear Settings
Network Info.

ITEMS OPTION
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12.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using SyncThru™ Web Service
• Using the Smart Panel program

• Smarthru
• Using SetIP program
• Using the Linux Unified Driver Configurator

Supported optional devices and features may differ according to your 
model. Please check your model name. 
(See "Features by Models" on page 25.)

INTRODUCING USEFUL MANAGEMENT TOOLS
The programs below help you to use your machine conveniently.
• "Using SyncThru™ Web Service" on page 82.
• "Using the Smart Panel program" on page 83.
• "Smarthru" on page 83.
• "Using the Linux Unified Driver Configurator" on page 84.

USING SYNCTHRU™ WEB SERVICE
Your SyncThru™Web Service window that appears in this user’s 
guide may differ depending on the machine in use.

If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via 
SyncThru™Web Service, an embedded web server. Use SyncThru™Web 
Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™Web Service:
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

SyncThru™Web Service overview

• Information tab: This tab gives you general information about your 
machine. You can check things, such as the machine’s IP address, 
remaining amount of toner, ethernet information, firmware version, and 
so on. You can also print reports such as an error report and so on. 

• Machine Settings tab: This tab allows you to set options provided by 
your machine. 

• Network Settings tab: This tab allows you to view and change the 
network environment. You can set things, such as TCP/IP, enabling 
Ether Talk and so on. 

• Maintenance tab: This tab allows you to maintain your machine by 
upgrading firmware and setting security information. 

• Support tab: This tab allows you to set contact information for sending 
email. You can also connect to SEC website or download drivers by 
selecting Link. 

Setting the contact information
Set the machine administrator information and this setting is necessary to 
use E-mail notification option.
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. Select Support.
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4. Enter the name of machine administrator, phone number, location or 
E-mail address.. 

5. Click Apply.
If the firewall is activated, the E-mail may not be sent successfully. 
In that case, contact the a network administrator.

USING THE SMART PANEL PROGRAM
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s settings. Smart Panel is 
installed automatically when you install the machine software.

To use this program, you need the following system requirements:
• Windows. Check for windows operating system(s) compatible with 

your machine. (See "System requirements" on page 32.)
• Mac OS X 10.3 or higher
• Linux. Check for Linux systems that are compatible with your 

machine. (See "System requirements" on page 32.)
• Internet Explorer version 5.0 or higher for flash animation in HTML 

Help.
If you need to know the exact model name of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while printing,  you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 
You can also click it on the status bar (in Mac OS X).

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > Samsung Printers > your printer driver 
name > Smart Panel.

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart 
Panel icon and select your machine.

• The Smart Panel window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in 

use.
The Smart Panel program displays the current status of the machine, the 
level of toner remaining in the toner cartridge(s), and various other types of 
information. You can also change settings.

1

2

3
This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open troubleshooting section in the user’s 
guide. 

4 If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

5

Opening the Troubleshooting Guide
Find solutions for problems by using the Troubleshooting Guide.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Troubleshooting Guide.

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Options. Select the settings you want from the Options
window. 

SMARTHRU
The supplied software CD provides you with SmarThru. SmarThru offers 
you convenient features to use with your machine.

USING SETIP PROGRAM
This program is for the network IP setting using the MAC address which is 
the hardware serial number of the network printer card or interface.

Windows Double-click this icon in Windows.

Macintosh Click this icon in Mac OS X.

Linux Click this icon in Linux.

Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

Buy Now Order replacement toner cartridge(s) online.

User’s Guide View User’s Guide.

Printer 
Setting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

Driver Setting Set all of the machine options you need in the 
Printer Preferences window. This feature is 
available only for Windows. (See "Opening 
printing preferences" on page 55.)
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It is especially for the network administrator to set several network IPs at the 
same time. 

You can only use the SetIP program when your machine is connected 
to a network. 

Windows
The following procedure is based on the Windows XP operating system.

Installing the program 
1. Insert the software CD provided with your machine. When the 

software CD runs automatically, close the window.
2. From the Start menu select My Computer and open the X drive. ( X 

represents your CD-ROM drive.)
3. Double click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK.

If necessary, select a language from the drop-down list.
6. Follow the instructions in the window to complete the installation.

Printing out the machine’s MAC address
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until Network Info. appear and press OK.
You can find your machine’s MAC address and IP address.

Setting network values
1. Print the machine’s network configuration report to find your 

machine’s MAC address. 
2. From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.
3. Click to open the TCP/IP configuration window. 
4. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

5. The machine prints the network information. Confirm all the settings 
are correct. 

6. Close the SetIP program. 

Macintosh
SetIP program should be automatically installed during the printer driver 
installation.

Printing out the machine’s MAC address
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until Network Info. appear and press OK.
You can find your machine’s MAC address and IP address.

Setting network values
If you want to change your network printer IP setting, follow the below 
instruction.

If you select Typical installation for a network printer during the 
printer driver installation, the SetIP program automatically runs 
after the installation. Go to step 4.

1. Print the machine’s network configuration report to find your 
machine’s MAC address. 

2. Open the Library folder > Printers > Samsung > your printer 
model name > SetIP.

3. Double click the SetIPApplet.html file. 
4. The certificate window appears, click Trust.
5. Click to open the TCP/IP configuration window. 
6. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

7. The machine prints the network information. Confirm all the settings 
are correct. 

8. Close the SetIP program. 

Linux
SetIP program should be automatically installed during the printer driver 
installation.

Printing out the machine’s MAC address
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appear and press OK.
3. Press the left/right arrow until Network Info. appear and press OK.
You can find your machine’s MAC address and IP address.

Setting network values
1. Print the machine’s network configuration report to find your 

machine’s MAC address. 
2. Open the /opt/Samsung/mfp/share/utils/.
3. Double click the SetIPApplet.html file. 
4. Click to open the TCP/IP configuration window. 
5. Enter the network card’s MAC address, IP address, subnet mask, 

default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

6. The machine prints the network information. Confirm all the settings 
are correct. 

7. Close the SetIP program. 

USING THE LINUX UNIFIED DRIVER 
CONFIGURATOR
The supplied software CD provides you with the Linux Unified Driver 
package for using your machine with a Linux computer.
Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. Since a machine device combines the printer and 
scanner, the Linux Unified Driver Configurator provides options logically 
grouped for printer and scanner functions. There is also a special machine 
port option responsible for the regulation of access to a machine printer and 
scanner via a single I/O channel. Also, you can monitor a number of 
machine devices via fast ECP parallel ports and USB simultaneously.
After the driver is installed on your Linux system, the Linux Unified Driver 
Configurator icon will automatically be created on your desktop

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.
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2. Click each button on the left to switch to the corresponding configuration 
window.  

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

1

2

3

The printer control buttons are, as follows:

• Refresh: Renews the available machines list.
• Add Printer: Allows you to add a new machines.
• Remove Printer: Removes the selected machine.
• Set as Default: Sets the current selected machine as a default 

machine.
• Stop/Start: Stops/starts the machine.
• Test: Allows you to print a test page to ensure the machine is 

working properly.
• Properties: Allows you to view and change the printer properties. 

Classes tab
The Classes tab shows a list of available machine classes.

1

2

• Refresh: Renews the classes list.
• Add Class: Allows you to add a new machine class.
• Remove Class: Removes the selected machine class.

1 Printers 
Configuration 

2 Scanners 
Configuration 

3 Ports 
Configuration 

Switches to Printers configuration.

Shows all of the installed machine.

Shows the status, model name and URI of your machine.

Shows all of the machine classes.

Shows the status of the class and the number of machines in the 
class.
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Scanners configuration
In this window, you can monitor the activity of scanner devices, view a list of 
installed Samsung machine devices, change device properties, and scan 
images.

1

2

3

• Properties: Allows you to change the scan properties and scan a 
document. 

Ports configuration
In this window, you can view the list of available ports, check the status of 
each port and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

1

2

3

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.

Sharing Ports Between Printers and Scanners
Your machine may be connected to a host computer via a parallel port 
or USB port. Since the machine device contains more than one device 
(printer and scanner), it is necessary to organize proper access of 
“consumer” applications to these devices via the single I/O port.
The Unified Linux Driver package provides an appropriate port sharing 
mechanism that is used by Samsung printer and scanner drivers. The 
drivers talk to their devices via so-called machine ports. The current 
status of any machine port can be viewed via the Ports configuration.
The port sharing prevents you from accessing one functional block of 
the machine device, while another block is in use.
When you install a new machine device onto your system, it is strongly 
recommended you do this with the assistance of an Unified Driver 
Configurator. In this case you will be asked to choose I/O port for the 
new device. This choice will provide the most suitable configuration for 
machine’s functionality. For machine scanners, I/O ports are being 
chosen by scanner drivers automatically, so proper settings are applied 
by default.

Switches to Scanners configuration.

Shows all of the installed scanners.

Shows the vendor, model name and type of your scanner. 

Switches to Ports configuration.

Shows all of the available ports.

Shows the port type, device connected to the port, and status
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13.maintenance
This chapter provides information for maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Finding the serial number
• Cleaning a machine

• Storing the Toner cartridge
• Tips for moving & storing your machine

PRINTING A MACHINE REPORT
You can print the machine's information and job report.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Report appear and press OK.
4. Press the left/right arrow until the report or list you want to print 

appears.press OK.
To print all reports and lists, select All Report.

5. Press the left/right arrow to appear Yes at the Print? prompt and press 
OK.

You can use SyncThru™ Web Service to print the machine's 
configuration or browse the status. Open the web browser in the 
networked computer and type the machine's IP address. When 
SyncThru™ Web Service opens, click Information > Print
Information.

MONITORING THE SUPPLIES LIFE
If you experience frequent paper jams or printing problems, check the 
number of pages the machine has printed. Replace the corresponding 
parts, if necessary.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Maintenance appear and press OK.
4. Press the left/right arrow until Supplies Life appear and press OK.
5. Press the left/right arrow until the item you want appears and press OK.

• Supplies Info: Prints the supply information page.
• Total: Displays the total number of pages printed.
• ADF Scan: Displays the number of pages scanned using the ADF.
• Platen Scan: Displays the number of pages scanned using the 

scanner glass.
6. Press Stop/Clear to return to ready mode.

USING TONER LOW ALERT
If the amount of toner in the cartridge is low, The Status LED blinks red. 
You can set the option for this LED to blink or not. 
1. Ensure that you have installed the printer driver with the provided     

Printer Software CD.
2. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X.

3. Click Printer Setting.
4. Click Setting > Toner Low Alert. Select the appropriate setting and 

then click Apply.

FINDING THE SERIAL NUMBER
When you call for service or register as a user on the Samsung website, the 
machine’s serial number by taking the following steps:
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Maintenance appear and press OK.
4. Press the left/right arrow until Serial Number appear and press OK.
5. Check your machine’s serial number.
6. Press Stop/Clear to return to ready mode.

CLEANING A MACHINE
If printing quality problems occur or if you use your machine in a dusty 
enviroment, you need to clean your machine regularly to keep the best 
printing condition and use your machine longer.

• Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet. 

• If your machine or the surrounding area is contaminated with 
toner, we recommend you use cloth or tissue dampened with 
water to clean it. If you use a vacuum cleaner, toner blows in the 
air and might be harmful to you.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.
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1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Open the front door and pull the toner cartridge out. Set it on a clean flat 
surface

• To prevent damage to the toner cartridge, do not expose it to 
light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.

3. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

While cleaning the inside of the machine, be careful not to damage 
the transfer roller or any other inside parts. Do not use solvents 
such as benzene or thinner to clean. Printing quality problems can 
occur and cause damage to the machine.

4. Locate the long strip of glass (LSU) inside the top of the cartridge 
compartment and gently clean the glass with a swab.

5. Reinsert the toner cartridge and close the front door.
6. Plug in the power cord and turn the machine on.

Cleaning the scan unit
Keeping the scan unit clean helps ensure the best possible copies. We 
suggest that you clean the scan unit at the start of each day and during the 
day, as needed.
1. Slightly dampen a soft, lint-free cloth or paper towel with water.
2. Open the scanner lid.
3. Wipe the surface of the scanner glass and the document feeder glass 

until it is clean and dry.

4. Wipe the underside of the scanner lid and white sheet until it is clean 
and dry.

5. Close the scanner lid.

STORING THE TONER CARTRIDGE
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations to ensure the optimum performance, highest quality, and 
longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet.

1 Scanner lid
2 Scanner glass
3 Document feeder 

glass
4 White sheet
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Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:
• Inside the protective bag from the original package. 
• Correct side up in a horizontal position (not standing on end).
• Do not store consumables in;

- Temperature greater than 40°C (104°F).
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges.

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or bad print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely. 
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14.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Clearing original document jams
• Tips for avoiding paper jams

• Clearing paper jams
• Understanding display messages
• Solving other problems

REDISTRIBUTING TONER
When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• Toner Low appears on the display.
• The Status LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Open the front door.
2. Pull the toner cartridge out.

3. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

Do not touch the green underside of the toner cartridge. Use the 
handle on the cartridge to avoid touching this area. 

4. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 

machine will guide the cartridge into the correct position until it locks into 
place completely.

5. Close the front door. Ensure that the cover is securely closed. 

CLEARING ORIGINAL DOCUMENT JAMS
When an original jams while passing through the document feeder, a 
warning message appears on the display screen.

To avoid tearing the document, remove the jammed document slowly 
and gently.

To prevent document jams, use the scanner glass for thick, thin, or 
mixed paper-type originals.



Troubleshooting_ 91

1. Remove any remaining pages from the document feeder.
2. Open the document feeder cover.

3. Gently remove the jammed paper from the document feeder.

If you see no paper in this area, go to step 5.

4. Close the document feeder cover. Reload the pages you removed, if 
any, in the document feeder.

5. Open the scanner lid.
6. Seize the misfeed paper, and remove the paper from the feed area by 

carefully pulling it to the right using both hands.

7. Close the scanner lid. Load the removed pages back into the document 
feeder.

TIPS FOR AVOIDING PAPER CURLS
1. Open the rear door.
2. Pull down the pressure lever on each side.

Keep the rear cover opened during printing. 
Only use when the printout has more than 20 mm curl. 

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the next guidelines. 
• Ensure that the adjustable guides are positioned correctly. (See 

"Loading paper in the tray" on page 49.)
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.

1 scanner lid

1 Pressure lever
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• Do not mix paper types in a tray.
• Use only recommended print media. (See "Setting the paper size and 

type" on page 52.)
• Ensure that the recommended side of the print media is facing down in 

the tray, or facing up in the manual tray.

CLEARING PAPER JAMS
When a paper jam occurs, a warning message appears on the display. 
To resume printing after clearing paper jams, you must open and close the 
front door.

To avoid tearing the paper, pull the jammed paper out slowly and 
gently. Follow the instructions in the following sections to clear the 
jam. 

In tray 1
Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.
If the paper does not exit, go to the next step.

2. Pull out tray 1 .

3. Remove the jammed paper by gently pulling it straight out.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check the fuser area around the toner cartridge. (See 
"Inside the machine" on page 92.)

4. Insert tray 1 back into the machine until it snaps into place. Printing 
automatically resumes.

In the manual tray
Click this link to open an animation about clearing a jam.

1. If the paper is not feeding properly, pull the paper out of the machine.

2. Open and close the front door to resume printing.

Inside the machine
Click this link to open an animation about clearing a jam.

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the front door and pull the toner cartridge out, lightly pushing it 
down.
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2. Remove the jammed paper by gently pulling it straight out.

3. Replace the toner cartridge and close the front door. Printing 
automatically resumes.

In exit area
Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.
If you do not see the jammed paper, go to next step.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

3. Open the rear door.
4. Pull the pressure levers down and remove the paper. 

5. Return the pressure levers to their original position.
6. Close the rear door.
7. Open and close front door, printing automatically resumes. 

1 Pressure lever
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UNDERSTANDING DISPLAY MESSAGES
Messages appear on the control panel display to indicate the machine’s 
status or errors. Refer to the tables below to understand the messages’ and 
their meaning, and correct the problem, if necessary.

Checking display messages
• If a message is not in the table, reboot the power and try the 

printing job again. If the problem persists, call for service.
• When you call for service, provide the service representative with 

the contents of display message.
• Some messages may not appear in the display depending on 

options or models.

SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Paper feeding problems

• Check the maximum paper capacity of the 
tray. (See "Print media specifications" on 
page 109.)

• Make sure that you are using the correct type 
of paper. (See "Print media specifications" on 
page 109.)

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. (See "Print media specifications" on 
page 109.)

• If an original does not feed into the machine, 
the document feeder rubber pad may require 
to be replaced. Contact a service 
representative.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the manual tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. (See "Print media 
specifications" on page 109.)

• There may be debris inside the machine. 
Open the front door and remove any debris.

• If an original does not feed into the machine, 
the document feeder rubber pad may need to 
be replaced. Contact a service representative.

CONDITION SUGGESTED SOLUTIONS

Paper jams during 
printing.

Clear the paper jam. (See "Clearing paper jams" 
on page 92.)

Paper sticks 
together.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

The paper keeps 
jamming.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.
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Printing problems

CONDITION POSSIBLE 
CAUSE

SUGGESTED
SOLUTIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections.

The machine is not 
selected as the 
default machine.

Select your machine as your 
default machine in your 
Windows.

Check the machine for the following:
• The front door is not closed. Close the front 

door.
• Paper is jammed. Clear the paper jam. (See 

"Clearing paper jams" on page 92.)
• No paper is loaded. Load paper. (See "Loading 

paper in the tray" on page 49.)
• The toner cartridge is not installed. Install the 

toner cartridge.
If a system error occurs, contact your service 
representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
cable and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different machine cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct. . (See "Opening 
printing preferences" on 
page 55.)

The printer driver 
may be incorrectly 
installed.

Repair the machine 
software. (See "Installing 
USB connected machine’s 
driver" on page 33, 
"Installing wired network or 
USB connected machine’s 
driver" on page 39.)

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.

The machine 
does not print. 

The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Get more hard disk space 
and print the document 
again.

The output tray is 
full.

Once the paper is removed 
from the output tray, the 
machine resumes printing.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing 
Preferences may 
be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the Printing Preferences.
Select the correct paper 
source. See the printer 
driver help screen. (See 
"Opening printing 
preferences" on page 55.)

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
cable and reconnect. Try a 
print job that you have 
already printed successfully. 
If possible, attach the cable 
and the machine to another 
computer that you know 
works and try a print job. 
Finally, try a new machine 
cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

CONDITION POSSIBLE
CAUSE

SUGGESTED 
SOLUTIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF file correctly. 
Some parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

It will take longer to 
print when you print a 
PDF file as an image.

The print quality 
of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct paper size in 
the Custom Paper Size 
Settings in the Paper tab in 
the Printing Preferences.
(See "Opening printing 
preferences" on page 55.)

CONDITION POSSIBLE 
CAUSE

SUGGESTED
SOLUTIONS CONDITION SUGGESTED SOLUTIONS

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life. (See"Redistributing toner" 
on page 90.) If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 109.)

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. (See "Cleaning the inside" on 
page 87.)

• The surface of the LSU part inside the 
machine may be dirty. (See "Cleaning the 
inside" on page 87.)

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

Toner specks • The paper may not meet specifications; for 
example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 109.)

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. (See "Print 
media specifications" on page 109.)

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to Thick. (See "Opening 
printing preferences" on page 55.)

• If these steps do not correct the problem, 
contact a service representative.
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White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine. (See 
"Cleaning the inside" on page 87.).

• The paper path may need cleaning. (See 
"Cleaning the inside" on page 87.)

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one. (See "Replacing the 
toner cartridge" on page 103.)

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. (See "Cleaning the 
inside" on page 87.)

Black background If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. (See "Print 

media specifications" on page 109.)
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old toner cartridge and, install a 
new one. (See "Replacing the toner 
cartridge" on page 103.)

Toner smear If toner smears on the page: 
• Clean the inside of the machine. (See 

"Cleaning the inside" on page 87.)
• Check the paper type and quality. (See "Print 

media specifications" on page 109.)
• Remove the toner cartridge and then, install 

a new one. (See "Replacing the toner 
cartridge" on page 103.)

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, instll a new one. (See 
"Replacing the toner cartridge" on 
page 103.)

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

A
CONDITION SUGGESTED SOLUTIONS

Background 
scatter

Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in Printing Preferences. (See 
"Opening printing preferences" on page 55.)

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper. (See 
"Print media specifications" on page 109.)

• If characters are improperly formed and 
producing a wavy effect, the scanner unit may 
need service. (See "Cleaning the scan unit" 
on page 88.)

A a B b CA a B b CA a B b CA a B b CA a B b C c

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 109.)
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. (See "Print media specifications" on 
page 109.)

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

CONDITION SUGGESTED SOLUTIONS
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Copying problems

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 109.)
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

A

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine. (See "Cleaning the inside" on 
page 87.)

Solid Color or 
Black pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 103.)

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. (See 
"Cleaning the inside" on page 87.)

• Check the paper type and quality. (See "Print 
media specifications" on page 109.)

• Remove the toner cartridge and then, install a 
new one. (See "Replacing the toner cartridge" 
on page 103.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

A
Character Voids Character voids are white areas within parts of 

characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications. (See "Print media 
specifications" on page 109.)

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

CONDITION SUGGESTED SOLUTIONS

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 103.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin. (See "Opening printing 
preferences" on page 55.)

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine. (See 
"Altitude adjustment" on page 43.)

CONDITION SUGGESTED SOLUTION

Copies are too light 
or too dark

Use Darkness in Copy feature to lighten or 
darken the backgrounds of copies. (See 
"Changing the darkness" on page 62.)

Smears, lines, 
marks, or spots 
appear on copies.

• If the defects are on the original, use 
Darkness in Copy feature to lighten the 
background of your copies. (See "Changing 
the darkness" on page 62.)

• If there are no defects on the original, clean 
the scan unit. (See "Cleaning the scan unit" 
on page 88.)

Copy image is 
skewed.

• Ensure that the original is face down on the 
scanner glass or face up in the document 
feeder.

• Check that the copy paper is loaded correctly.

Blank copies print 
out.

Ensure that the original is face down on the 
scanner glass or face up in the document 
feeder.

CONDITION SUGGESTED SOLUTIONS
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Scanning problems

• Make sure that you place the original to be 
scanned face down on the scanner glass, or 
face up in the document feeder.

• There may not be enough available memory 
to hold the document you want to scan. Try 
the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine cable is connected 
properly.

• Make sure that the machine cable is not 
defective. Switch the cable with a known 
good cable. If necessary, replace the cable.

• Check that the scanner is configured 
correctly. Check scan setting in the 
SmarThru Office or the application you want 
to use to make certain that the scanner job 
is being sent to the correct port (for example, 
USB001).

• Check if the machine is printing received 
data. If so, scan the document after the 
received data has been printed.

• Graphics are scanned more slowly than text.
• Communication speed slows in scan mode 

because of the large amount of memory 
required to analyze and reproduce the 
scanned image. Set your computer to the 
ECP printer mode through BIOS setting. It 
will help to increase the speed. For details 
about how to set BIOS, refer to your 
computer user’s guide.

• Device can’t be 
set to the H/W 
mode you want.

• Port is being used 
by another 
program.

• Port is Disabled.
• Scanner is busy 

receiving or 
printing data. 
When the current 
job is completed., 
try again.

• Invalid handle.
• Scanning has 

failed.

• There may be a copying or printing job in 
progress. Try your job again when that job is 
finished.

• The selected port is currently being used. 
Restart your computer and try again.

• The machine cable may be improperly 
connected or the power may be off.

• The scanner driver is not installed or the 
operating environment is not set up properly.

• Ensure that the machine is properly 
connected and the power is on, then restart 
your computer.

• The USB cable may be improperly 
connected or the power may be off.

Image rubs off the 
copy easily.

• Replace the paper in the tray with paper from 
a new package.

• In high humidity areas, do not leave paper in 
the machine for extended periods of time.

Frequent copy paper 
jams occur.

• Fan the stack of paper, then turn it over in the 
tray. Replace the paper in the tray with a fresh 
supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper paper 
weight.

• Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam 
has been cleared.

Toner cartridge 
produces fewer 
copies than 
expected before 
running out of toner.

• Your originals may contain pictures, solids, or 
heavy lines. For example, your originals may 
be forms, newsletters, books, or other 
documents that use more toner.

• The scanner lid may be left open while copies 
are being made.

• Turn the machine off and back on. 

CONDITION SUGGESTED SOLUTION

CONDITON SUGGESTED SOLUTIONS

The scanner does not 
work. 

The unit scans very 
slowly. 

Message appears on 
your computer 
screen:
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Fax problems

• Unplug the power cord and plug it in again.
• Ensure that there is power being supplied to 

the electrical outlet.

• Check that the phone line is properly 
connected.

• Check that the phone socket on the wall is 
working by plugging in another phone.

• Make sure that the paper is not wrinkled and 
you are inserting it in correctly. Check that the 
original is the right size, not too thick or thin.

• Make sure that the document feeder is firmly 
closed.

• The document feeder rubber pad may need to 
be replaced. Contact a service 
representative.

• The receiving mode should be set to fax.
• Make sure that there is paper in the tray.
• Check to see if the display shows any error 

message. If it does, clear the problem

• Make sure that the original is loaded in the 
document feeder or on the scanner glass. 

• Check the fax machine you are sending to, to 
see if it can receive your fax.

• The fax machine sending you the fax may be 
faulty. 

• A noisy phone line can cause line errors.
• Check your machine by making a copy.
• The toner cartridge may be empty. Replace 

the toner cartridge. (See "Replacing the toner 
cartridge" on page 103.)

Samsung Scan Manager Problem

Common Windows problems

Refer to Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

CONDITION SUGGESTED SOLUTIONS

The machine is not 
working, there is no 
display, or the 
buttons are not 
working.

No dial tone.

The numbers stored 
in memory do not 
dial correctly.

Make sure that the numbers are stored in 
memory correctly. Print a Addess Book list. 
(See "Setting up address book" on page 75.)

The original does 
not feed into the 
machine.

Faxes are not 
received 
automatically.

The machine does 
not send.

The incoming fax 
has blank spaces or 
is of poor-quality.

Some of the words 
on an incoming fax 
are stretched.

The fax machine sending the fax had a 
temporary document jam. 

There are lines on 
the originals you 
sent.

Check your scan unit for marks and clean it. 
(See "Cleaning the scan unit" on page 88.)

The machine dials a 
number, but the 
connection with the 
other fax machine 
fails.

The other fax machine may be turned off, out of 
paper, or cannot answer incoming calls. Speak 
with the other machine operator and ask her/him 
to solve out the problem.

Faxes do not store in 
memory.

There may not be enough memory space to 
store the fax. If the display indicating the 
memory status shows, delete any faxes you no 
longer need from the memory, and then try to 
store the fax again. Call for service.

Blank areas appear 
at the bottom of 
each page or on 
other pages, with a 
small strip of text at 
the top

You may have chosen the wrong paper settings 
in the user option setting. For details about 
paper settings. (See "Setting the paper size and 
type" on page 52.)

CONDITION SUGGESTED SOLUTION

Samsung Scan 
Manager does not 
work. 

Check your system requirements. Samsung 
Scan Manager works in Window and Macintosh 
(See "System requirements" on page 32.)

CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

CONDITION SUGGESTED SOLUTIONS
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Common Linux problems
CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred. For 
instance, this could be an attempt to print a 
document when the port is claimed by a 
scanning application.

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
“consumer” applications to the same port is 
possible. To avoid possible conflicts, only one 
of them at a time is allowed to gain control 
over the device. The other “consumer” will 
encounter “device busy” response. You 
should open ports configuration and select 
the port assigned to your machine. In the 
Selected port pane you can see if the port is 
occupied by some other application. If this is 
the case, you should either wait for 
completion of the current job or press the 
Release port button, if you are sure that the 
present application is not functioning properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing.Use the socket 
printing instead of ipp or install a later version 
of CUPS (cups-1.1.22 or higher).

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252.The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I cannot scan via 
Gimp Front-end.

Check if Gimp Front-end has Xsane:Device 
dialog. on the Acquire menu. If not, you should 
install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package 
for Gimp on Linux distribution CD or Gimp home 
page. For the detailed information, refer to the 
Help for Linux distribution CD or Gimp Front-end 
application. 
If you wish to use another kind of scan 
application, refer to application’s Help.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.

The machine does 
not appear on the 
scanners list.

• Ensure your machine is attached to your 
computer, connected properly via the USB 
port, and is turned on.

• Ensure the scanner driver for your machine is 
installed in your system. Open Unified Linux 
Driver configurator, switch to Scanners 
configuration, then press Drivers. Make 
sure that driver with a name corresponding to 
your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
“consumer” applications to the same port is 
possible. To avoid possible conflicts, only one 
of them at a time is allowed to gain control 
over the device. The other “consumer” will 
encounter “device busy” response. This 
usually happens when starting a scan 
procedure. An appropriate message box 
appears.
To identify the source of the problem, open 
the Ports configuration and select the port 
assigned to your scanner, port's symbol 
/dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1, and so on. USB ports start at 
/dev/mfp4, so scanner on USB:0 relates to 
/dev/mfp4 respectively and so forth 
sequentially. In the Selected port pane, you 
can see if the port is occupied by another 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present port applicaton is not 
functioning properly.

CONDITION SUGGESTED SOLUTIONS
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Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

Common Macintosh problems

It will take longer to print when you print a 
PDF file as an image.

Refer to Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.

The machine does 
not scan.

• Ensure a document is loaded into the 
machine, ensure your machine is connected 
to the computer.

• If there is an I/O error while scanning.

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X10.3.2.

Update your MAC OS to MAC OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS cannot create the font during the cover 
page printing. The English alphabet and 
numbers are displayed normally on the cover 
page.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

CONDITION SUGGESTED SOLUTIONS
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15.supplies and accessories
This chapter provides information on purchasing supplies  accessories and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies
• Available maintenance parts

• Replacing the toner cartridge
• Checking replaceable’s lifespan

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE
To order Samsung-authorized supplies  accessories and, maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

AVAILABLE SUPPLIES

• MLT-D105S
• Region Ab:

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus, 
Czech Republic, Denmark, Finland, France, Germany, Greece, 
Hungary, Italy, Macedonia, Netherlands, Norway, Poland, Portugal, 
Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, Switzerland, UK. 

MLT-D1052S
• Region Bc:

c. Region B: China only. 

• MLT-D105L
• Region Ab:

MLT-D1052L
• Region Bc:

MLT-D1053L

MLT-D1053S

When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

To replace a toner cartridge  (See "Replacing the toner cartridge" on 
page 103.)

Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

You must purchase supplies, including toner cartridges, in the same 
country where you  purchased your machine. Otherwise, supplies will 
be incompatable with your machine since the system configuration of 
these vary from country to country.

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty.

AVAILABLE MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

To purchase maintenance parts, contact the source where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. The 
warranty does not cover the replacement of any maintenance parts after 
their lifespan.

REPLACING THE TONER CARTRIDGE
Click this link to open an animation about replacing a toner cartridge.

When the toner cartridge is empty:
• Toner Empty appears on the display. 
• The machine stops printing. Incoming faxes are saved in memory. 
At this stage, the toner cartridge needs to be replaced. Check the type of the 
toner cartridge for your machine. (See "Available supplies" on page 103.)

TYPE AVERAGE YIELDa

a.Declared yield value in accordance with ISO/IEC 19752.

PART NAME

Standard yield Approx. 1,500 pages

High yield Approx. 2,500 pages

PARTS AVERAGE YIELDa

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

PART NAME

Document feeder 
rubber pad 

Approx. 20,000 pages RMO ADF 
RUBBER

Transfer roller Approx. 50,000 pages ROLLER-TRANSF
ER

Fuser unit Approx. 50,000 pages FUSER

Pickup roller Approx. 50,000 pages ROLLER-PICK UP

Cassette unit Approx. 50,000 pages CASSETTE
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1. Open the front door.
2. Pull the toner cartridge out.

3. Remove the new toner cartridge from its bag. 
4. Slowly shake the cartridge five or six times to distribute the toner evenly 

inside the cartridge. It will assure maximum copies per cartridge. 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

Do not touch the green underside of the toner cartridge. Use the 
handle on the cartridge to avoid touching this area. 

5. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 
place completely.

6. Close the front door. Make sure that the cover is securely closed. 

CHECKING REPLACEABLE’S LIFESPAN
If you experience frequent paper jams or printing problems, check the 
number of pages the machine has printed. Replace the corresponding 
parts, if necessary.
1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appear and press OK.
3. Press the left/right arrow until Maintenance appear and press OK.
4. Press the left/right arrow until Supplies Life appear and press OK.
5. Press the left/right arrow until the item you want appears and press OK.

• Supplies Info: Prints the supply information page.
• Total: Displays the total number of pages printed.
• ADF Scan: Displays the number of pages scanned using the ADF.
• Platen Scan: Displays the number of pages scanned using the 

scanner glass.
6. Press Stop/Clear to return to ready mode.
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16.specifications
This chapter guides you about this machine’s specifications such as various features.
This chapter include:
• General specifications
• Printer specifications
• Scanner specifications
• Copier specifications
• Facsimile specifications
• Print media specifications

GENERAL SPECIFICATIONS

• Tray: 250 sheets for plain paper, 80 g/m2 (20 lb bond)
• Manual tray: 1 sheet

• Average operating mode: Less than 420 W
• Ready mode: Less than 48 W
• Power save mode: Less than 10 W
• Power off mode: Less than 1 W

• Ready mode: 26 dB(A)
• Printing mode: 50 dB(A)
• Copying mode: 52 dB(A)

ITEM DESCRIPTION

Document feeder capacity Up to 40 sheets 75 g/m2 (20 lb bond) 

Document feeder document size Width: 142 to 216 mm (5.6 x 8.5 inches)/ Length: 148 to 356 mm (5.8 x 14 inches)

Paper input capacity

( See "Print media specifications" on page 109.)

Paper output capacity (Face down) 100 sheets 75 g/m2 (20 lb bond)

Power rating AC 110 - 127 V or AC 220 - 240 V
See the Rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.

Power consumption

Noise Levela

Boot-up timeb Less than 30 seconds

Operating environment Temperature: 10 to 32 °C (50 to 90 °F)
Humidity: 20 to 80% RH

Display 16 characters x 2 lines

Toner cartridge lifec SCX-4600 Series 700 pagesd (Shipped with the machine) (See "Available supplies" on page 103.)

SCX-4623 Series 1,000 pagesd (Shipped with the machine) (See "Available supplies" on page 103.)

Memory (Expandable)* 64 MB (Non-extendable): SCX-4600(K), SCX-4623F(K), SCX-4623FH(K)

128 MB (Non-extendable): SCX-4623FN

External dimension
(W x D x H)

SCX-4600 Series 416 x 409 x 275.8 mm (16.4 x 16.1 x 10.9 inches)

SCX-4623 Series 416 x 409 x 352 mm (16.4 x 16.1 x 13.9 inches)

Weight
(Including consumables)

SCX-4600 Series 10.5 Kg (23.15 lbs)

SCX-4623 Series 11.5 Kg (25.35 lbs)

Package weight Paper: 3.4 Kg (7.42 lbs)
Plastic: 1.1 Kg (2.42 lbs)
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PRINTER SPECIFICATIONS

• Windows: 2000/XP/2003/2008/Vista
• Various Linux OS ( See "Linux" on page 32.)
• Macintosh: Mac OS X 10.3~10.6

• High speed USB 2.0
• Ethernet 10/100 Base TX (Embedded type) (SCX-4623FN only)

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.
b.Boot-up time is the time that takes from the power switch on to the ready mode.
c. Declared yield value in accordance with ISO/IEC 19752. The number of pages may be affected by operating environment, printing interval, media type, and 

media size.
d. It varies depending on the product configuration.

ITEM DESCRIPTION

Printing method Laser beam printing

Printing speeda

a. It will be affected by operating system used, computing performance, application software, connecting method, media type, media size and job complexity.

Up to 22 ppm (A4), 23 ppm (Letter)

First print out time 10 seconds (from ready)

Print resolution Up to 1,200 x 1,200 dpi effective output

Printer language SPL

OS compatibilityb

b.Visit www.samsungprinter.com to download the latest software version.

Interface
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SCANNER SPECIFICATIONS

COPIER SPECIFICATIONS

• Up to 22 cpm (A4), 23 cpm (Letter)
• Up to 12 cpm (A4)b

b.For Austria, Belgium, Germany, Spain. (Copy speed varies by countries.)

ITEM DESCRIPTION

Compatibility TWAIN standard/WIA standard

Scanning method Color CIS

Resolutiona

a.Due to the applications for scanning, the maximum resolution might differ.

TWAIN standard Up to 600 x 600 dpi (Up to 4,800 x 4,800 dpi by software enhancement)

WIA standard Up to 600 x 600 dpi 

Scan to PC 75, 150, 200, 300, 600 dpi

Scan to Email 100, 200, 300dpi

Network Scan File format PDF, TIFF, JPEGb

b.JPEG is not available when you select the mono mode in scan color.

Effective scanning length Scanner glass: 297 mm (11.7 inches)
Document feeder: 348 mm (13.7 inches)

Effective scanning width Max. 208 mm (8.2 inches)

Color bit depth 24 bit

Mono bit depth 1 bit for lineart & halftone
8 bit for gray scale

ITEM DESCRIPTION

Copy Speeda

a.Copy speed is based on Single Document Multiple Copy.

Copy resolution Text Scanner glass: Up to 300 x 300 dpi
Document feeder: Up to 300 x 300 dpi

Text/photo Scanner glass: Up to 300 x 300 dpi
Document feeder: Up to 300 x 300 dpi

Photo Scanner glass: Up to 600 x 600 dpi
Document feeder: Up to 300 x 300 dpi

Zoom range Scanner glass: 25% to 400%
Document feeder: 25% to 100%
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FACSIMILE SPECIFICATIONS
The fax feature may not be supported depending on machines.

• Standard: 203 x 98 dpi
• Fine: 203 x 196 dpi
• Super Fine: 300 x 300 dpi

ITEM DESCRIPTION

Compatibility ITU-T G3

Applicable line Public Switched Telephone Network (PSTN) or behind PABX

Data coding MH/MR/MMR/JBIG/JPEG

Modem speed 33.6 Kbps

Transmission speed Up to 3 seconds/pagea

a.Standard resolution, MMR(JBIG), Maximum modem speed, Phase “C” by ITU-T No. 1 chart, Memory Tx, ECM.

Maximum document length 356 mm (14 inches)

Resolution

Memory 4 MB

Halftone 256 levels

Auto dialer up to 200 numbers
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PRINT MEDIA SPECIFICATIONS 

• 250 sheets of 80g/m2 (20 lb 
bond)

• 1 sheet stacking

• 150 sheets of 80 g/m2 (20 lb 
bond)

• 1 sheet stacking

• 1 sheet stacking

• 1 sheet stacking

• 1 sheet stacking

• 1 sheet stacking

• 1 sheet stacking

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHTa/CAPACITYb

a. If media weight is over 120 g/m2 (32 lb), load a paper into the tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 

TRAY1 MANUAL TRAY

Plain paper Letter 216 x 279 mm (8.50 x 11.00 inches) 60 to 120 g/m2 (16 to 32 lb bond) 60 to 220 g/m2 (16 to 43 lb bond) 

Legal 216 x 356 mm (8.50 x 14.00 inches)

US Folio 216 x 330 mm (8.50 x 13.00 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.50 x 13.50 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches) 60 to 90 g/m2 (16 to 24 lb bond) 

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.50 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

A6 105 x 148 mm (4.13 x 5.83 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.50 inches) Not available in tray1. 75 to 90 g/m2 (20 to 24 lb bond)

Envelope No. 10 105 x 241 mm (4.12 x 9.50 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 90 g/m2 (24 lb bond) 90 g/m2 (24 lb bond)

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lb bond) 60 to 70 g/m2 (16 to 19 lb bond)

Transparency Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1. 138 to 146 g/m2 (36.81 to 38.91 
lb bond)

Labelsc

c. Smoothness: 100 to 250 (sheffield)

Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement

Refer to the Plain paper section Not available in tray1. 120 to 150 g/m2 (32 to 40 lb 
bond)

Card stock Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5, 
Statement, PostCard 
4x6

Refer to the Plain paper section Not available in tray1. 105 to 163 g/m2 ( 28 to 43 lb 
bond)

Minimum size (custom) 76 x 127 mm (3.00 x 5.00 inches) 60 to 163 g/m2 (16 to 43 lb bond) 

Maximum size (custom) 216 x 356 mm (8.50 x 14.02 inches)
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

ARGENTINE 0800-333-3733 www.samsung.com/ar

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com/at

BELGIUM 02 201 2418 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com/br

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca

CHILE 800-SAMSUNG (726-7864) www.samsung.com/cl

CHINA 800-810-5858
400-810-5858
010-6475 1880

www.samsung.com/cn

COLOMBIA 01-8000112112 www.samsung.com.co

COSTA RICA 0-800-507-7267 www.samsung.com/latin

CZECH
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com/cz

Samsung Zrt., eská organiza ní složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk

ECUADOR 1-800-10-7267 www.samsung.com/latin

EL SALVADOR 800-6225 www.samsung.com/latin

ESTONIA 800-7267 www.samsung.com/ee

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 30-6227 515 www.samsung.com/fi

FRANCE 01 4863 0000 www.samsung.com/fr

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.de

GUATEMALA 1-800-299-0013 www.samsung.com/latin

HONDURAS 800-7919267 www.samsung.com/latin

HONG KONG 3698-4698 www.samsung.com/hk

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com/hu

INDIA 3030 8282
1800 110011
1800 3000 8282 

www.samsung.com/in

INDONESIA 0800-112-8888 www.samsung.com/id

ITALIA 800-SAMSUNG(726-7864) www.samsung.com/it

JAMAICA 1-800-234-7267 www.samsung.com/latin

JAPAN 0120-327-527 www.samsung.com/jp

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 02 261 03 710 www.samsung.com/lu

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com/mx

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com/nl

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com/nz

NICARAGUA 00-1800-5077267 www.samsung.com/latin

NORWAY 3-SAMSUNG (7267864) www.samsung.com/no

PANAMA 800-7267 www.samsung.com/latin

PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com/ph

POLAND 0 801 1SAMSUNG 
(172678) 
022-607-93-33

www.samsung.com/pl

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com/pt

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com/sg

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com/sk

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com/za

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com/es

SWEDEN 075-SAMSUNG (726 78 64) www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com/ch

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com/latin

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864)
8000-4726

www.samsung.com/ae

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com/uk

U.S.A 1-800-SAMSUNG 
(7267864)

www.samsung.com/us

UKRAINE 8-800-502-0000 www.samsung.ua

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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glossary
The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g
802.11b/g can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps. 
802.11b/g devices may occasionally suffer interference from microwave 
ovens, cordless telephones, and Bluetooth devices. 

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.



Glossary_ 113

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 
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Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 

compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.
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NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a machine like printer which contains toner. Toner 
is a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.
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A
adjusting

tray size 45

answering machine/fax 72

authentication
printing a report 79

B
booklet printing 56

booklets 56

buttons
power 30

C
cleaning

inside 87
outside 87
scan unit 88

cleaning a machine 87

control panel 28, 29

convention 22

copy setup 78

copy timeout setting 64

copying
adjusting darkness 62
basic copying 62
changing the copy setup 78, 64
ID card copy 63
n-up copy 63
poster copy 63
reducing or enlarging copies 62
selecting the size of originals 62

D
date setting 43

default settings
changing the default settings 44
loading paper 44
setting a fax header 70
tray setting 52

display 28

display screen 29

document feeder 48

duplex printing (manual)
printer driver 56

E
Entering

using the number keypad 44

error message 94

extension telephone 73

F
favorites settings, for printing 55

fax receiving
activating secure receive 73
changing the receive mode 72
DRPD mode 73
extension telephone 73
in answering machine/fax 72, 73
secure receiving 73

fax sending
delay sending 71
multi sending 71
redialing the last number 71
sending a fax 70, 72

fax setup 77

faxing
address book 75, 74, 73
changing receiving mode 72, 77
delaying a fax transmission 71
forwarding faxes 74
group dial 75
preparing to fax 70
receiving 72, 73, 72, 73, 71
sending 70, 72, 70, 75

features 24
machine features 77, 105
power saving feature 45, 109, 54
supplied software 31

front view 26

G
glossary 112

I
ID copy 63

information 9

J
jam

clearing paper 92
tips for avoiding paper jams 91

job timeout setting 46

L
language 43

LCD display
changing the display language 43

LED
machine status 30
power saver 30
understanding the status LED 30

Linux
common Linux problems 101
driver installation for network connected 

41, 34
printer properties 61, 60
scanning 68, 32
unifled driver configurator 84, 39, 84

loading
in the document feeder 48
originals on the scanner glass 47
paper in manual tray 49
special media 50

M
Macintosh

common Macintosh problems 102
driver installation for network connected 

41, 34
printing 59
scanning 67, 36, 32
using SetIP 38, 84

maintenance parts 103

manual tray
loading 49
tips on using 49
using special media 50

index
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memory
clearing memory 79

menu overview 80

N
network

driver installation
Linux 41
Macintosh 41
Windows 39

installing environment 37
IPv6 configuration 42
SetIP program 38, 39, 83
using a wired network 37

network setup 80

N-up copy 63

N-up printing
Macintosh 60
Windows 55

O
on hook dial

hardware 28

original document
clearing jam 90
loading

in the document feeder 48
on the scanner glass 47

original type
copying 62

output support 53

overlay printing
create 58
delete 58
print 58

P
placing a machine

adjusting the altitude 43
spacing 31

poster, print 56

power saver
button 30
using power save mode 45

print media
card stock 52
envelope 51
glossy paper 52, 48
labels 51, 52
output support 109
photo paper 52

setting the default tray and paper
in the computer 45

 52
transparency 51

print resolution set
Linux 61

print resolution, set
Macintosh 60

printer driver
features 54

printer preferences
Linux 61

printer properties 55

printing
changing the default print settings 58, 57
fitting your document to a selected paper 

size 57
Linux 60
Macintosh 59
multiple pages on one sheet of paper

Macintosh 60
Windows 55

poster 56
Windows 54, 56

 59
using overlay 57

printing a document
Linux 60
Macintosh 59

problems
copying problems 98
paper feeding problems 94, 96

R
rear view 27

regulatiory information 13

reports
network MAC address 84

resolution
faxing 73

S
safety

information 9
symbols 9

scanner
glass 47
lid 26, 47

scanner glass
loading documents 47

scanning
basic information 65
changing the default settings 44
for local connection 65
Linux 68
Macintosh 67
TWAIN 67
WIA 67

serial number 87

service contact numbers 110

SetIP program 38, 39, 83

Smart Panel
general information 83

specifications
copier 107
faximile 108
general 105
print media 109, 106
scanner 107

start button 28, 29

stop button 28, 29

supplies
available supplies 103
estimated toner cartridge life 89
monitoring the supplies life 87
ordering 103
replacing toner cartridge 103

SyncThruTM Web Service
general information 82

T
time setting 43

toner cartridge
estimated life 89, 105
handling instructions 89
non-Samsung and refilled 89
redistributing toner 90, 103
storing 88

toner save mode 45

tray
adjusting the width and length 48
changing the tray size 48
loading paper in manual tray 49
setting the paper size and type 52

turning on the machine 30

TWAIN, scan 67

U
understanding the control panel

power button 30
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USB cable
driver installation 33

using setip program
Linux 84
Macintosh 84
Windows 84

W
watermark

create 57
delete 57
edit 57
print 57

WIA
scan 67

Windows
common Windows problems 100
driver installation for network connected 

39, 33
printing 54
scanning 65, 35, 32
using SetIP 38, 84


